[image: image1.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors



February 4, 2003


[image: image3.png]First

Gloria
Molina

Second

District

Yvonne Michael D.

Brathwaite Yaroslav Antonovich
Burke

The Meeting Transcript of
The Los Angeles County
Board of Supervisors






Adobe Acrobat Reader 5.0

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

       To find the next occurrence of the word: 

        Do one of the following:

        Choose Edit > Find Again 

        Reopen the find dialog box, and click Find Again.  (The word must already be in the         Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last letter.  

       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.

3. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[REPORT OF ACTION TAKEN IN CLOSED SESSION

FEBRUARY 4, 2003 BEGINS ON PAGE 87]
 SUP. BURKE, CHAIR: THE MEETING WILL COME TO ORDER. AS WELL AS THE ADJOURNED REGULAR MEETING OF JANUARY 28th 2003, WHICH WAS ADJOURNED TO FEBRUARY 3rd 2003, AND THEREAFTER ADJOURNED TO TODAY, SO THAT MEETING IS ADJOURNED AND I WOULD ASK THAT BEFORE WE HEAR THE INVOCATION, WHICH WILL BE LED BY PASTOR DUDLEY C. RUTHERFORD OF THE SHEPHERD OF HILLS, PORTER RANCH, FROM THE FIFTH DISTRICT, AND THE PLEDGE OF ALLEGIANCE LED BY MILDRED M. GARVEY, MEMBER OF THE EXECUTIVE COMMITTEE OF THE NINETEENTH DISTRICT OF SOUTH BAY POST NUMBER 183, THE AMERICAN LEGION FROM THE FOURTH DISTRICT, THAT WE STAND AND OBSERVE A MOMENT OF SILENCE FOR THE ASTRONAUTS OF THE SPACE SHUTTLE COLUMBIA. [ Moment of Silence ] REVEREND RUTHERFORD, WOULD YOU PLEASE PRAY?

PASTOR RUTHERFORD: FATHER WE THANK YOU FOR ANOTHER BEAUTIFUL DAY HERE IN THE CITY OF LOS ANGELES, WE THANK YOU FOR THE BOARD OF SUPERVISORS AND FOR THE WORK THAT THEY DO FOR OUR COUNTY IN WHICH WE LIVE. WE KNOW FATHER THERE ARE ALWAYS A LOT OF NEEDS AND A LOT OF PEOPLE WHO NEED TO BE HEARD, A LOT OF DECISIONS THAT NEED TO BE MADE. WE JUST PRAY FATHER FOR YOUR WISDOM, WE ASK GOD FOR YOUR GUIDANCE, WE THANK YOU FATHER FOR THE BLESSING OF LIFE. WE DO PRAY FOR THE FAMILY MEMBERS OF THE SPACE SHUTTLE, TODAY FATHER SPECIFICALLY THAT YOU WOULD GIVE THEM STRENGTH AND GIVE THEM COURAGE. YOU KNOW FATHER THAT THE DAYS THAT WE LIVE HERE TODAY THAT WE NEVER KNOW WHAT'S GOING TO TAKE PLACE AND WE JUST PRAY THAT EACH AND EVERY DAY THAT WE WOULD HONOR YOU WITH OUR LIFE AND WITH OUR WORDS AND WE PRAY SPECIFICALLY ALSO TO GOD TODAY FOR ALL THE DECISIONS THAT ARE MADE IN THIS ROOM. GOD THERE'S SO MUCH THAT NEEDS TO BE DONE, SO MANY DECISIONS THAT HAVE TO BE MADE, AND WE JUST TRUST IN YOU, WE TRUST IN YOUR WISDOM, WE TRUST IN YOUR COUNSEL, THANK YOU AGAIN FOR ALL OF THE SUPERVISORS AND FOR ALL THE WORK THAT THEY DO, MAY THEY KNOW HOW MUCH THEY ARE APPRECIATED FOR THE WORK THAT THEY DO, WE ASK YOUR BLESSING ON EVERYTHING THAT HAPPENS IN THIS ROOM HERE TODAY, WE PRAY IN YOUR NAME. 

MILDRED M. GARVEY: WOULD YOU PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEART. [ Pledge of Allegiance ] 

SUP. BURKE, CHAIR: AND MAY I NOTE THAT THE FLAGS ARE FLYING AT HALF STAFF OVER ALL COUNTY FACILITIES AT THIS TIME. 

SUP. KNABE: MADAM CHAIR, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, IT'S MY PLEASURE TO PRESENT A CERTIFICATE OF APPRECIATION TO MILDRED GARVEY, SHE IS A RESIDENT OF REDONDO BEACH AND BELONGS TO THE SOUTH BAY POST NUMBER 184 OF THE AMERICAN LEGION. MILDRED SERVED IN THE UNITED STATES AIR FORCE IN THE 563rd ARMY AIR FORCE AND ROSE TO THE RANK OF CORPORAL. SHE CURRENTLY SERVES AS VICE PRESIDENT COMMANDER FOR WOMEN LOS ANGELES COUNTY COUNSEL, AND RETIRED FROM A CAREER AT SEARS. BUT THE MOST IMPORTANT PART WAS THE -- A NOTE THAT WAS ADDED BY JOE, AND THAT SAYS "THIS YOUNG LADY MADE HER FIRST PARACHUTE JUMP ON HER 75th BIRTHDAY". THANK YOU, MILDRED. [ Applause ] 

SUP. ANTONOVICH: I BELIEVE SHE RANKS UP THERE WITH PRESIDENT GEORGE BUSH, SR., WHO JUMPED ON HIS 70th BIRTHDAY OUT OF AN AIRPLANE, BUT I UNDERSTAND BARBARA SAID NO MORE PARACHUTING FOR HIM. TODAY WE HAVE PASTOR DUDLEY RUTHERFORD, WHO IS THE SENIOR PASTOR AT THE SHEPHERD OF THE HILLS CHURCH IN PORTER RANCH IN THE SAN FERNANDO VALLEY. THE PASTOR COMES FROM A LONG LINE OF CLERGY IN HIS FAMILY FROM GRANDFATHER, FATHER, UNCLES AND ALL AND BROTHERS. HE HAS SERVED AS VICE PRESIDENT OF THE NORTH AMERICAN CHRISTIAN CONVENTION AND HAS HAD THE DISTINCTION OF SPEAKING FOR SEVERAL PROFESSIONAL SPORTS TEAMS AND WAS THE FEATURE CHAPEL SPEAKER DURING THE RECENT WORLD SERIES. AND WE JUST RECENTLY HAD REPRESENTATIVES FROM THE CALIFORNIA ANGELS WHO WERE HERE TO RECOGNIZE THEM FOR THE GREAT CHAMPIONSHIP THAT THEY BROUGHT TO THIS GREAT STATE. SO WE WOULD LIKE YOU GIVE YOU THIS CERTIFICATE AND THANK YOU FOR LEADING US IN PRAYER THIS MORNING. [ Applause ] 

CLERK VARONA-LUKENS: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD. WE'LL BEGIN ON PAGE 4. ON ITEM S-1, THE DIRECTOR OF HEALTH SERVICES REQUESTS A FOUR-WEEK CONTINUANCE TO MARCH 4, 2003. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION, CONTINUED TO MARCH 4th. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: BOARD OF SUPERVISORS ITEMS 1 THROUGH 18. I HAVE THE FOLLOWING REQUEST. ON ITEM NUMBER 9, HOLD FOR SUPERVISOR YAROSLAVSKY AND SUPERVISOR KNABE. 

SUP. BURKE, CHAIR: ON THE REMAINDER. 

CLERK VARONA-LUKENS: I'M SORRY, MADAM CHAIR. 

SUP. BURKE, CHAIR: OKAY SURE. 

CLERK VARONA-LUKENS: ON ITEM NUMBER 10 AS NOTED ON THE GREEN SHEET, SUPERVISOR KNABE REQUESTS THAT THE ITEM BE CONTINUED TO MARCH 4, 2003. ON ITEM NUMBER 13, SUPERVISOR ANTONOVICH REQUESTS A ONE-WEEK CONTINUANCE. AND THE REST ARE BEFORE YOU. 

SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY ANTONOVICH, SECONDED BY KNABE. AND WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 19 THROUGH 23. ON ITEM NUMBER 23, HOLD FOR SUPERVISOR KNABE. 

SUP. BURKE, CHAIR: ON THE OTHERS, REMAINING ITEMS, MOVED BY KNABE SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGRICULTURAL COMMISSIONER/ WEIGHTS AND MEASURES, ITEM 24. 

SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ARTS COMMISSION, ITEM 25. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AUDIT COMMITTEE, ON ITEM 26, HOLD FOR GENEVIEVE CLAVREUL. 

SUP. BURKE, CHAIR: SO WE'LL HOLD THAT. 

CLERK VARONA-LUKENS: AND CHILDREN AND FAMILY SERVICES. ON ITEM 27, SUPERVISOR ANTONOVICH REQUESTS A ONE-WEEK CONTINUANCE. 

SUP. BURKE, CHAIR: NUMBER 27 WILL BE CONTINUED FOR ONE WEEK, WITHOUT OBJECTION. 

CLERK VARONA-LUKENS: COMMUNITY AND SENIOR SERVICES, ITEMS 28 AND 29. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: CONSUMER AFFAIRS, ITEM 30. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: HEALTH SERVICES, ITEMS 31 THROUGH 34. ON ITEM NUMBER 34, HOLD FOR SUPERVISOR KNABE. 

SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: HUMAN RESOURCES. ON ITEM 35, HOLD FOR SUPERVISOR KNABE. MENTAL HEALTH, ITEM 36. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PARKS AND RECREATION, ITEM 37. 

SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC SOCIAL SERVICES, ITEM 38 AND 39. ON ITEM NUMBER 38, HOLD FOR SUPERVISOR BURKE AND SUPERVISOR MOLINA REQUESTS A TWO-WEEK CONTINUANCE ON THAT ITEM AS WELL. 

SUP. KNABE: WHICH ITEM IS THAT? 

CLERK VARONA-LUKENS: 38. 

SUP. BURKE, CHAIR: I JUST HAD AN AMENDMENT, SO I'LL PASS OUT THE AMENDMENT. 

CLERK VARONA-LUKENS: SO WE'LL HOLD IT? 

SUP. BURKE, CHAIR: AND THEN WE CAN CONTINUE IT. 

CLERK VARONA-LUKENS: AND THEN CONTINUE IT. 

SUP. BURKE, CHAIR: HOLD IT? ALL RIGHT. WE'LL HOLD 38. 

CLERK VARONA-LUKENS: OKAY. AND SO 39 IS BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY MOLINA, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC WORKS, ITEMS 40 THROUGH 62. ON ITEM NUMBER 40, THE DIRECTOR REQUESTS A ONE-WEEK CONTINUANCE CONTINUANCE. 

SUP. BURKE, CHAIR: WE'LL HOLD AND -- WE'LL CONTINUE THAT FOR ONE WEEK, NUMBER 40. ON ITEM 40, THE DIRECTOR REQUESTS A ONE-WEEK CONTINUANCE. AND THAT'LL BE CONTINUED. 

CLERK VARONA-LUKENS: AND ON ITEM 45, HOLD FOR SUPERVISOR YAROSLAVSKY. 

SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ON PAGE 26, REGISTRAR RECORDER ITEMS -- ON ITEM 63, HOLD FOR SUPERVISOR ANTONOVICH AND ITEM 64, HOLD FOR GENEVIEVE CLAVREUL. ON THE SHERIFF, ITEMS 65 AND 66, ON 65, THE SHERIFF REQUESTS A TWO-WEEK CONTINUANCE TO FEBRUARY 18, 2003. ITEM 66 IS BEFORE YOU. 

SUP. BURKE, CHAIR: THERE WAS -- IT WAS A HOLD BY PETER BAXTER. WE'RE HOLDING IT FOR MR. BAXTER. 

CLERK VARONA-LUKENS: OKAY. EXCUSE ME MR. BAXTER. 

SUP. BURKE, CHAIR: ON 65, THAT WILL BE CONTINUED FOR TWO WEEKS. WITHOUT OBJECTION. 

CLERK VARONA-LUKENS: OKAY. TREASURER AND TAX COLLECTOR, ITEMS 67 AND 68. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: MISCELLANEOUS COMMUNICATIONS, ON ITEM 69, PETER BAXTER ALSO REQUESTS THAT THAT ITEM BE HELD, BUT THE COUNTY COUNSEL IS REQUESTING A ONE-WEEK CONTINUANCE. 

SUP. BURKE, CHAIR: ALL RIGHT. MR. BAXTER, IF IT'S ALL RIGHT WITH YOU, WE'LL CONTINUE THAT ONE WEEK. 

SPEAKER: [ Inaudible ] 

CLERK VARONA-LUKENS: I'M SORRY MR. BAXTER, EXCUSE ME. 

SUP. BURKE, CHAIR: I THINK IT WAS PROBABLY JUST A MISTAKE. ALL RIGHT THEN ITEM 69 WILL BE CONTINUED FOR ONE WEEK WITHOUT OBJECTION. 

CLERK VARONA-LUKENS: ITEM NUMBER 70, AN ORDINANCE EXTENDING THROUGH JUNE 30, 2005, A FRANCHISE TO PROVIDE CABLE TELEVISION SERVICE IN THE CLAREMONT UNINCORPORATED AREAS AND REFLECTING A NAME CHANGE OF THE FRANCHISEE FROM MEDIA ONE OF ILLINOIS, INC. TO COM CAST OF CALIFORNIA 1 LLC. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCE FOR ADOPTION.  ON ITEM 71, THE COUNTY COUNSEL IS REQUESTING THAT THIS ITEM BE REFERRED BACK TO COUNTY COUNSEL FOR REVISIONS TO THE ORDINANCE CLARIFYING PROCEDURES FOR THE CIVIL SERVICE COMMISSION. 

SUP. BURKE, CHAIR: THAT ITEM WILL BE REFERRED BACK. 

CLERK VARONA-LUKENS: A SEPARATE MATTER, ON ITEM 72 IS THE TREASURE AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION APPROVING THE FINANCING BY THE CALIFORNIA STATEWIDE COMMUNITIES DEVELOPMENT AUTHORITY NOT TO EXCEED $17 MILLION ON BEHALF OF THE PAINTED TURTLE GANG CAMP FOUNDATION. THAT ITEM IS BEFORE YOU. 

SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC HEARING. ON ITEM 73, SUPERVISOR KNABE REQUESTS THAT THE ITEM BE CONTINUED WITHOUT DISCUSSION TO FEBRUARY 11, 2003, AT 9:30. 

SUP. BURKE, CHAIR: THIS ITEM, 73, WILL BE CONTINUED, TO FEBRUARY 11th, WITHOUT OBJECTION. I'M SORRY. GO AHEAD. 

CLERK VARONA-LUKENS: MISCELLANEOUS, ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE OFFICER, WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA. ON ITEM 77-A, HOLD FOR SUPERVISOR KNABE. ON THE SPECIAL AGENDA FOR THE HEALTH DEPARTMENT BUDGET COMMITTEE OF THE WHOLE -- 

SUP. ANTONOVICH: 74-A 

CLERK VARONA-LUKENS: I'M SORRY. 74-A, I STAND CORRECTED. 

SUP. BURKE, CHAIR: YEAH 74-A WILL BE HELD. 

CLERK VARONA-LUKENS: AND ON THE SPECIAL MEETING FOR THE DEPARTMENT, HEALTH DEPARTMENT BUDGET COMMITTEE OF THE WHOLE, THE DIRECTOR REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO FEBRUARY 11, 2003. 

SUP. BURKE, CHAIR: OKAY, WITHOUT OBJECTION, A SPECIAL MEETING AGENDA WILL BE CONTINUED FOR ONE WEEK TO FEBRUARY 11. AND THAT'S CONTINUED WITHOUT OBJECTION. 

CLERK VARONA-LUKENS: THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. BURKE, CHAIR: SUPERVISOR MOLINA, DO YOU HAVE ANY PRESENTATIONS? 

SUP. MOLINA: [ Inaudible ]. 

SUP. BURKE, CHAIR: ALL RIGHT. I HAVE ONE PRESENTATION. I'D LIKE TO ASK CHUCK HENRY, LINDA STEEL TO COME FORWARD, AND ALSO THE OFFICIALS FROM THE NATIONAL BLACK H.I.V./A.I.D.S. AWARENESS WEEK. H.I.V./A.I.D.S. CONTINUES TO BE A SCOURGE IN LOS ANGELES COUNTY AFFECTING EVERY STRATUM OF SOCIETY, AGE, RACE AND ETHNIC GROUPS. THE NATIONAL CENTER FOR DISEASE CONTROL AND PREVENTION ESTIMATES THAT YOUNG AFRICAN- AMERICAN GAY MEN ARE AT A GREATER RISK FOR H.I.V. INFECTION THAN ANY OTHER GROUP. H.I.V./A.I.D.S. REMAINS THE LEADING CAUSE OF DEATH IN THE UNITED STATES FOR ALL AFRICAN-AMERICAN MEN BETWEEN THE AGES OF 25 AND 44 YEARS OF AGE. IN THE COUNTY OF LOS ANGELES, A.I.D.S. IS INCREASINGLY BECOMING AN EPIDEMIC AMONG PEOPLE OF COLOR, EVEN THOUGH AFRICAN-AMERICANS COMPRISE LESS THAN 10% OF THE COUNTY'S TOTAL POPULATION. THEY MAKE UP 22% OF ALL PEOPLE LIVING WITH A.I.D.S. THERE IS A CRITICAL NEED FOR INCREASED AWARENESS AND PREVENTION OF H.I.V./A.I.D.S. AMONG ALL GROUPS, BUT MOST ESPECIALLY AMONG AFRICAN-AMERICANS. THERE IS A GROWING NEED FOR H.I.V. COUNSELING, H.I.V. TESTING AS APPROPRIATE AND ENHANCED H.I.V.-RELATED MEDICAL AND SOCIAL SERVICES FOR AFRICAN-AMERICANS. THEREFORE, THE BOARD OF SUPERVISORS JOINS COMMUNITIES IN LOS ANGELES, ATLANTA, BALTIMORE, CHICAGO, DALLAS, DETROIT, HOUSTON, MIAMI, NEW ORLEANS, NEW YORK, OAKLAND, PHILADELPHIA, AND RALEIGH DURHAM, WASHINGTON, D.C., IN PROCLAIMING THE WEEK OF FEBRUARY 1st THROUGH 7th AS NATIONAL BLACK H.I.V./A.I.D.S. AWARENESS WEEK, AND I'D LIKE TO MAKE THIS PRESENTATION, AND IS RICHARD HAMILTON HERE TO ACCEPT IT? AND HE'S OUR REPRESENTATIVE OF THE SECOND DISTRICT H.I.V. COMMUNITY COALITION AND COORDINATOR OF NATIONAL BLACK H.I.V. AWARENESS IN LOS ANGELES AND ALSO CHARLES WELLS AND PRECIOUS JACKSON WHO ARE MEMBERS OF THE SECOND DISTRICT H.I.V. COMMUNITY COALITION. WE HAVE CHUCK HENRY HERE, DIRECTOR OF THE COUNTY OFFICE OF H.I.V./A.I.D.S., WHO RECENTLY EARNED THE DISTINCTION OF BECOMING THE LONGEST-SERVING DIRECTOR OF THE A.I.D.S. OFFICE IN LOS ANGELES, AND LINDA STEEL, CLIENT SERVICE SECTION MANAGER FOR THE CARE SERVICE DIVISION OF OAPP AND LIAISON WITH THE SECOND DISTRICT. BUT -- AND DR. FIELDING IS HERE ALSO. I REALLY THINK IT WAS GREAT NEWS THAT I HEARD ON THE RADIO THAT THERE'S GOING TO BE A MEDIA TESTING. THERE'S BEEN AN UPGRADE IN TERMS OF THE ABILITY THAT SOON WILL BE, I GUESS, APPROVED, SO IT'S GOOD NEWS THAT PEOPLE WILL HAVE NO REASON NOT TO BE TESTED, AND IT'S SO IMPORTANT IN LOS ANGELES. DOING A GREAT JOB, BUT IT'S A TREMENDOUS CHALLENGE. 

RICHARD HAMILTON: GOOD MORNING. I AM RICHARD HAMILTON. I AM H.I.V. POSITIVE AND I'M H.I.V. EMPOWERED. I WOULD LIKE TO THANK SUPERVISOR BURKE WHO STANDS BY INDIVIDUALS LIVING WITH H.I.V. IN THE SECOND DISTRICT AND ALL OF L.A. COUNTY, AND ALSO THE BOARD OF SUPERVISORS FOR DECLARING FEBRUARY 1st THROUGH 7th NATIONAL BLACK H.I.V./A.I.D.S. AWARENESS DAY IN LOS ANGELES -- WEEK IN LOS ANGELES. THERE ARE THOSE OF US HERE TODAY REPRESENTING OUR COMMUNITY IN THE SECOND DISTRICT TO ACCEPT THIS PROCLAMATION. WE'RE LIVING WITH H.I.V. TODAY. OUR REPRESENTATIVES ARE CHARLES McWELLS, PRECIOUS JACKSON, AND MYSELF. OUR THEME THIS YEAR IS "GET EDUCATED, GET TESTED, GET INVOLVED." REPRESENTING "GET EDUCATED" IS CHARLES McWELLS. CHARLES McWELLS IS THE COMMUNITY DEVELOPMENT COORDINATOR AT THE DREW UNIVERSITY CENTER FOR A.I.D.S. RESEARCH, EDUCATION, AND SERVICES IN LOS ANGELES. IN HIS CAPACITY, MR. McWELLS HAS BEEN INSTRUMENTAL IN DEVELOPING A FOOD PANTRY AND COMMUNITY DROP-IN CENTER FOR H.I.V. POSITIVE PERSONS. HE HAS ALSO SPEARHEADED A NUMBER OF FUNDRAISERS FOR LOCAL A.I.D.S. SERVICE ORGANIZATIONS AND HAS SERVED AS STAFF LIAISON FOR THE SPECTRUM DREW PIERCE COMMUNITY ACTION COMMITTEE. MOST RECENTLY, MR. McWELLS HEADED THE DREW CARES DEVELOPMENT TEAM THAT CREATED THE PASSPORT TO CARE SUBSTANCE ABUSE TREATMENT PROGRAM FOR H.I.V. POSITIVE AFRICAN-AMERICANS AND LATINOS. IN ADDITION, TO HIS WORK IN H.I.V./A.I.D.S. FIELD, CHARLES McWELLS IS ALSO AN ACTOR AND A PLAYWRIGHT. HIS TWO-ACT DRAMA, "THE NINTH STEP" LAST MONTH, RECEIVED A NOMINATION FROM THE N.A.A.C.P. OUR OTHER PERSON ON "GET TESTED" IS MISS PRECIOUS JACKSON, IS A 31-YEAR-OLD AFRICAN-AMERICAN WOMAN LIVING WITH H.I.V. FOR THE PAST FOUR YEARS. MS. JACKSON IS A COMMUNITY ACTIVIST ON THE LOCAL AND NATIONAL LEVEL. SINCE 2001, MS. JACKSON HAS WORKED AT WOMEN ALIVE COALITION AS A TREATMENT ADVOCATE. SHE PROVIDES TREATMENT AND EDUCATION SERVICES TO WOMEN LIVING WITH H.I.V./A.I.D.S. THROUGHOUT LOS ANGELES COUNTY. THERE'S AN ETHIOPIAN PROVERB THAT SAYS, "HE WHO CONCEALS HIS DISEASE CANNOT EXPECT TO BE CURED." I AM REPRESENTING "GET INVOLVED." WE ARE A PEOPLE OF SELF-DETERMINATION AS WE ARE THE NEW FACES OF H.I.V., WE ARE EMPOWERED TO DISPEL THE STIGMA OF LIVING WITH H.I.V. AND A.I.D.S. GET EDUCATED, GET TESTED, GET INVOLVED. WE HAVE A T-SHIRT FOR ALL OF THE SUPERVISORS HERE AND A PEN. THANK YOU. [ Applause ] 

CHUCK HENRY: WE WANT TO THANK THE SUPERVISORS AND YOU, SUPERVISOR BURKE, AS CHAIR, FOR YOUR CONTINUED COMMITMENT TO FIGHTING ALONGSIDE WITH US IN THE DEPARTMENT AND IN THE COMMUNITY TO END THIS EPIDEMIC. CERTAINLY IN THE MIDST OF AFRICAN-AMERICAN HISTORY MONTH, WE TAKE THIS OPPORTUNITY TO HONOR AND CELEBRATE THE LIVES OF MANY MEMBERS OF THE AFRICAN-AMERICAN COMMUNITY ANCESTORS TO THE AFRICAN-AMERICAN COMMUNITY IN BRINGING FORWARD BOTH THEIR SPIRIT AND THEIR COMMITMENT AND CONTRIBUTIONS TO CREATING A FUTURE IN THE AFRICAN-AMERICAN COMMUNITY THAT'S FREE OF H.I.V. AND A.I.D.S. THANK YOU. [ Applause ] 

SUP. BURKE, CHAIR: SUPERVISOR YAROSLAVSKY, DO YOU HAVE MORE PRESENTATIONS? SUPERVISOR KNABE. [ Applause ] 

SUP. KNABE: THANK YOU, MADAM CHAIR. IT'S MY PLEASURE TO CALL FORWARD A MEMBER OF THE NORWALK CITY COUNCIL, THE HONORABLE SHERRY KELLY, JIM PARKER, WHO IS A DIRECTOR OF TRANSPORTATION FOR THE CITY OF NORWALK, NORWALK TRANSIT, AND MICHELLE MILLER, WHO IS THE COORDINATOR. TODAY, WE ARE PLEASED TO COMMEND NORWALK TRANSIT, A LOS ANGELES COUNTY MUNICIPAL OPERATOR, FOR ITS INNOVATION IN INTRODUCING A VERY UNIQUE AND CREATIVE WAY TO ATTRACT NEW RIDERS WHILE IMPROVING THE QUALITY OF LIFE FOR THEIR ENTIRE COMMUNITY THROUGH ITS "STUFF-A-BUS" PROGRAM. THIS PROGRAM SUPPORTS LOCAL NEEDY FAMILIES BY COLLECTING CLOTHING AND TOYS FOR DISTRIBUTION TO LOCAL CHARITABLE ORGANIZATION. THE BUS TRAVELS THROUGHOUT THE COMMUNITY AND DONATES TOYS AT VARIOUS SITES ALONG ITS ROUTE. ADDITIONALLY PASSENGERS CAN DONATE A CAN OF FOOD IN LIEU OF A BOARDING FEE. IT'S AN OUTSTANDING PROGRAM THAT DESERVES COMMENDATION AND OBVIOUSLY NORWALK TRANSIT IS COMMITTED TO PUBLIC TRANSPORTATION, AND PARTICULARLY THE NEEDS OF ITS COMMUNITY IN IMPROVING THE QUALITY OF LIFE FOR ALL ITS RESIDENTS. SO ON BEHALF OF MY COLLEAGUES AND MYSELF, WE'D LIKE TO PRESENT THIS SCROLL IN RECOGNITION OF THE NORWALK TRANSIT FIRST ANNUAL "STUFF A BUS" PROGRAM. [ Applause ] 

JIM PARKER: THANK YOU, SUPERVISOR KNABE, AND EVERYONE PRESENT. WE REALLY APPRECIATE THE RECOGNITION. THERE ARE A LOT OF NEEDY FAMILIES DURING THE TIME OF THE HOLIDAYS, WHICH MAKES IT MUCH MORE EVIDENT, THE GIVING ON BEHALF OF OUR PASSENGERS, THE GIVING ON BEHALF OF OUR STAFF AND THE CITY EMPLOYEES. WE'RE REALLY HEARTFELT AND I THINK WE WERE BLESSED AS MUCH AS THE RECIPIENTS, SO THANK YOU AGAIN. [ Applause ] 

SUP. KNABE: NOW IT'S MY PLEASURE TO CALL FORWARD DEACON BRUCE SAGO AND HIS WIFE, LEA. DEACON BRUCE AS WE KNOW HIM, HAS SERVED A STRONG AND EFFECTIVE LEADER IN THE UNINCORPORATED AREA OF WHITTIER SERVING AS DEACON AND PASTORAL ASSOCIATE AT THE SAINT GREGORY THE GREAT CATHOLIC CHURCH, A PARISH OF OVER 4200 FAMILIES, SINCE 1998. NOW NEARLY AFTER FIVE YEARS OF ACTIVE COMMUNITY SERVICE, AND HE PROMISES ME HE'S GOING TO STILL LIVE THERE AND BE ACTIVE, DEACON BRUCE WILL BE TRANSFERRING TO THE SAINT ROBERT BALLARMIN CATHOLIC CHURCH IN BURBANK, MOVING OVER TO ANOTHER DISTRICT. DEACON BRUCE IS WELL KNOWN FOR HIS COMMUNITY OUTREACH ACTIVITIES AND EFFORTS NOT ONLY TO THE PARISH BUT TO THE COMMUNITY AS A WHOLE. HE SERVED AS DIRECTOR OF CHRISTIAN OUTREACH MINISTRY, AND THE MOST WIDESPREAD OF HIS UNDERTAKINGS IS THE CREATION OF "NEIGHBORS HELPING NEIGHBORS", WHICH IS A FAMILY EMERGENCY SERVICE CENTER THAT PROVIDES ASSISTANCE TO ALL RESIDENTS IN NEED OF HOUSING, FOOD, CLOTHING, AND SOCIAL SERVICES. DEACON BRUCE IDENTIFIED THIS GAP IN SERVICE AND DILIGENTLY WORKED TOWARD ITS COMPLETION. HE'S A CHAPLAIN WITH THE WHITTIER POLICE DEPARTMENT AND OUR SHERIFF'S DEPARTMENT AND MOST RECENTLY WAS APPOINTED A MEMBER OF THE LOS ANGELES COUNTY DEPARTMENT OF REGIONAL PLANNING'S HOUSING AND ADVISORY COMMITTEE WHERE HE FOCUSED HIS EFFORTS ON HELPING REVITALIZE BLIGHTED AREAS. AND SO DEACON BRUCE, WE'RE GOING TO MISS YOU. WE WISH YOU THE VERY, VERY BEST AND GOD SPEED IN YOUR POSITION IN BURBANK, BUT WE KNOW THAT YOU'RE NOT LEAVING OUR COMMUNITY. THANK YOU. [ Applause ] 

DEACON BRUCE SAGO: I WOULD LIKE TO THANK SUPERVISOR KNABE AND THE COUNTY OF LOS ANGELES AND THE OTHER SUPERVISORS. WE STARTED OUR OUTREACH PROGRAM, ENTITLED IT "NEIGHBORS HELPING NEIGHBORS" BECAUSE THAT'S EXACTLY WHAT IT WAS. IT'S ALL VOLUNTEERS AND IT'S ALL PEOPLE WHO'VE COME FOR HELP AND THEN RETURNED TO HELP OTHERS, AND THANKS TO SUPERVISOR KNABE, WE WERE ABLE TO GET A COMMUNITY DEVELOPMENT BLOCK GRANT TO HELP FUND IT ALONG WITH THE PRIVATE DONATIONS AND DONATIONS FROM CHURCHES AND COMMUNITIES AND SERVICE GROUPS, AND SO I THANK YOU AND WE HOPE TO CONTINUE THE WORK. [ Applause ] 

SUP. KNABE: MADAM CHAIR, I'M FINISHED THANKS. 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: THIS MORNING WE'D LIKE TO RECOGNIZE TWO OUTSTANDING CORPORATE LEADERS IN OUR COUNTY OF LOS ANGELES, AND THAT'S THE WARNER CABLE AND H.B.O., BECAUSE THEY'RE GOING TO BE PROVIDING A FREE SCREENING OF THIS 74-MINUTE ORIGINAL DOCUMENTARY FILM, "UNCHAINED MEMORIES: READINGS FROM THE SLAVE NARRATIVES." THIS IS GOING TO BE DONE THIS SUNDAY IN CANOGA PARK. AND THIS MOVING HISTORIC FILM IS A COLLABORATION BETWEEN THE LIBRARY OF CONGRESS AND H.B.O. IT BRINGS THE WORDS OF FORMER SLAVES TO VIVID LIFE THROUGH ON-CAMERA READINGS BY CELEBRATED AFRICAN-AMERICANS AS WELL AS PHOTOGRAPHERS, MUSIC, FILM, AND PERIOD IMAGES. BETWEEN 1936 AND 1938, MORE THAN 2,000 INTERVIEWS WITH ONE-TIME SLAVES WERE CONDUCTED FORMING A UNIQUE FIRSTHAND RECORD OF SLAVE LIFE, NARRATED BY WHOOPI GOLDBERG, THE FILM FEATURES EMOTION-CHARGED READINGS BY ANGELA BASSETT, SAMUEL JACKSON, OPRAH WINFREY AND DON CHEATO. IN ADDITION TO THEIR IN-CHARACTER READINGS, THERE ARE OTHER COMMENTARIES AND EDITORIAL COMMENTS THAT THEY GIVE GIVING A TEMPORARY EMOTIONAL PERSPECTIVE TO THE DOCUMENTARY'S SERIOUS SUBJECT MATTER. AS I SAID, ON FEBRUARY 9th, AT 3:00 P.M., TIME WARNER CABLE WILL PRESENT THE DOCUMENTARY AT NO COST TO THE PUBLIC AND IT'S AT THE MADRID THEATRE IN CANOGA PARK AT 21622 SHERMAN WAY, 21622 SHERMAN WAY. IMMEDIATELY FOLLOWING THE SCREENING, PASTOR BROADUS OF THE COUNTY OF LOS ANGELES COMMISSION ON HUMAN RELATIONS WILL LEAD A PANEL DISCUSSION WITH THE PANELISTS AND THE AUDIENCE. SO AT THIS TIME, WE WOULD LIKE TO RECOGNIZE DEAN LEVINWORTH, WHO'S THE DIVISIONAL VICE PRESIDENT OF CORPORATE RELATIONS AND COMMUNICATIONS FOR TIME WARNER CABLE AND PATRICIA McKINLEY WHO IS THE H.B.O. EXECUTIVE AND WE ALSO HAVE, DID PASTOR BROADUS COME -- THE PASTOR DIDN'T COME BUT WE ALL KNOW, SO FIRST TO TIME WARNER. [ Applause ] 

SUP. ANTONOVICH: PATRICIA, THANK YOU. 

PATRICE McKINLEY: AS THIS GENTLEMAN SAID, MY NAME IS PATRICE McKINLEY AND I AM A REPRESENTATIVE FROM H.B.O. HERE IN LOS ANGELES. IF YOU ARE UNABLE TO ATTEND THE FREE SCREENING OF "UNCHAINED MEMORIES: READINGS FROM THE SLAVE NARRATIVES," YOU CAN WATCH THIS PROGRAM EXCLUSIVELY ON H.B.O. IT PREMIERS ON H.B.O. ON FEBRUARY 10th AT 8:00 P.M. THANK YOU. [ Applause ] 

DEAN LEVINWORTH: TIME WARNER IS THRILLED TO BE ABLE TO PRESENT THIS AMONG A NUMBER OF COMMUNITY SCREENINGS TO TRY AND BRING IMPORTANT ISSUES TO THE PUBLIC AND TO INVOLVE THE PUBLIC IN DISCUSSIONS ABOUT THEM. I'M VERY PLEASED THAT REVEREND BROADUS WILL BE LEADING A PANEL DISCUSSION. WE FEEL THAT PART OF BETTER UNDERSTANDING IS A DIALOGUE, AND WE ARE VERY PLEASED TO BE A PART OF IT, AND I LOOK FORWARD TO SEEING THE SUPERVISOR AND ANYONE ELSE THERE AT 3:00, IT SHOULD BE A WONDERFUL EVENT. THANK YOU VERY MUCH FOR THIS RECOGNITION. [ Applause ] 

SUP. ANTONOVICH: AGAIN, THAT ADDRESS IS AT THE MADRID THEATRE IN CANOGA PARK AT 21622 SHERMAN WAY, AND WE LOOK FORWARD TO SEEING YOU THERE ON SUNDAY. NOW WE WOULD LIKE TO RECOGNIZE A YOUNG HERO, AND THIS IS A YOUNG LADY NAMED LEAH HELSBECK. SHE'S 15 YEAR OLD, FROM ALTADENA, AND THROUGH ALERTNESS, SHE WAS ABLE TO WAKE UP VERY EARLY IN THE MORNING ON JANUARY 6 WHEN THE HIGH WINDS CAUSED A LARGE PINE TREE BRANCH TO PULL DOWN SIX OVERHEAD WIRES, WHICH SPARKED THE FIRE ON EAST PINE STREET IN ALTADENA. NOW, THIS WOKE HER UP AND SHE WENT AND AWAKENED HER PARENTS, QUICKLY GETTING INTO ACTION HER MOTHER LYN CALLED 9-1-1 WHILE HER FATHER, TOM, WORKED TO EXTINGUISH THE FIRES WITH A HOSE. SO JOINING LEAH THIS MORNING ARE HER PARENTS, AND AT THIS TIME WE WOULD LIKE TO RECOGNIZE HER FOR HER QUICK ACTION, AND BEING A HERO NOT JUST FOR ALTADENA, BUT IN LOS ANGELES COUNTY. CONGRATULATIONS. [ Applause ] 

SUP. ANTONOVICH: AND HER BROTHER NOAH IS AS WELL. 

LEAH HELSBECK: THANK YOU. [ Applause ] 

LYN HELSBECK: I NEVER DREAMED THAT 15 YEARS AGO WHEN I HAD LEAH THAT SHE WOULD BE A HERO, BUT I'M REALLY PROUD OF HER. THANK YOU, SUPERVISOR ANTONOVICH, AND I JUST WANT TO SAY THANK YOU TO THE SPECIAL ED, ALL HER TEACHERS THAT SHE'S HAD IN THE PASADENA SCHOOL DISTRICT. ONE OF THE AIDES IS WITH US HERE TODAY AND ALSO THE WISE SPIRIT PROGRAM WHICH IS AN OUTREACH OF THE Y.M.C.A. WHICH HELPS TEENAGERS AFTER SCHOOL HAVE A SAFE PLACE TO GO AND HELPS TAKE THEM OUT INTO THE COMMUNITY AND GIVE THEM THE LIFE SKILLS THEY NEED TO BE A PART OF OUR WORLD. SO THANK YOU VERY MUCH. [ Applause ] 

MR. HELSBECK: WE'RE A CLOSE-KNIT GROUP UP IN ALTADENA, AND I LIKE TO THINK WE TAKE CARE OF EACH OTHER AND LOOK OUT FOR EACH OTHER AND THIS WAS JUST OUR SMALL PART AND WE WERE HAPPY TO DO IT. 

SUP. ANTONOVICH: DO YOU WANT TO SAY ANYTHING NOAH? OKAY LEAH, WE'LL DO A PICTURE WITH THE FAMILY. 

SUP. ANTONOVICH: NOW WE WANT TO WELCOME CONNIE McCORMICK, OUR REGISTRAR RECORDER, WHO IS HERE TO JOIN IN WELCOMING THOSE WHO HOSTED AND TOUCHED THE TOUCH SCREEN EARLY VOTING IN THE LAST GUBERNATORIAL ELECTION. THERE WERE 21 SITES THROUGHOUT THE COUNTY AT LIBRARIES, SHOPPING MALLS, AND IN COMMUNITY AND CIVIC CENTERS, AND FROM OCTOBER 22nd THROUGH NOVEMBER 1st, THE REGISTERED VOTERS WERE ABLE TO ACCESS THEIR OWN BALLOT CONFIGURATIONS AND CAST THEIR VOTE MILES FROM THEIR LOCAL PRECINCTS USING THIS NEW ELECTRONIC VOTING TECHNOLOGY. THEY HELPED VOTERS AS THE COUNTY TRANSITIONS TO A NEW VOTING SYSTEM AND PHASES AFTER THE DECERTIFICATION OF ITS 35-YEAR-OLD PUNCH-CARD SYSTEM. AND WE'RE PROUD TO HAVE SAID THAT WE REALLY DIDN'T HAVE THE CHAD PROBLEMS DURING THOSE 35 YEARS, BUT ANYWAY... THE PERCENTAGE OF TOUCH SCREENS VOTING DOUBLED FROM THAT IN THE ELECTION YEAR PILOT FROM 2000 PILOT PROGRAM. THE NEXT PHASE WILL CALL FOR ALL VOTERS IN WHOLE PRECINCTS WITH THE ABILITY OF USING TOUCH SCREEN VOTING IN THE MARCH 4th MUNICIPAL ELECTIONS, AND THIS WILL BE AVAILABLE IN THE UPCOMING ELECTIONS IN SOUTH PASADENA, GARDENA, IRWINDALE, BEVERLY HILLS, LA PUENTE AND SIGNAL HILL. SO WE HAVE THESE PROCLAMATIONS WE WANT TO GIVE YOU. DO YOU WANT TO SAY SOMETHING FIRST? 

CONNIE McCORMICK: I'D LIKE TO THANK SUPERVISOR ANTONOVICH AND THE BOARD FOR RECOGNIZING OUR TOUCH SCREENS SITE HOUSE. WE HAD 21 LOCATIONS. THEY ALL DID A FANTASTIC JOB IN INTRODUCING MORE AND MORE OF THE PUBLIC TO THE NEW TOUCH SCREEN VOTING SYSTEMS. THANK YOU. 

SUP. ANTONOVICH: FIRST, REPRESENTING THE DIRECTOR OF PARKS AND RECREATION IS ANTHONY MONTANISS. ASHER SHUTNER, MARKETING COORDINATOR OF WESTFIELD SHOPPING TOWN IN FOX HILLS. HELEN KOWAJOVE, CITY CLERK FOR THE CITY OF CARSON. NINA WEBSTER, CITY CLERK FOR THE CITY OF BEVERLY HILLS. DOUG FISHER, MANAGER OF THE PANORAMA MALL. REBECCA BULLOCK, CONSUMER SERVICE MARKETING COORDINATOR FOR THE TOPANGA PROMENADE. BARRY CAGE, CHIEF OPERATIONS OFFICER FOR THE BRAILLE INSTITUTE. AARON SHONENOVER, ATTENDING FOR REDONDO BEACH LIBRARY DIRECTOR, GENE SCULLY. CAPTAIN JOHN HARRISON FOR CHIEF MICHAEL FRIEDMAN FOR THE LOS ANGELES COUNTY FIRE DEPARTMENT. PATSY LANE, DIRECTOR OF HUMAN SERVICES RECREATION FOR THE CITY OF PASADENA AND CHRISTINE HARRIS IS REPRESENTING PATSY. JIM BAGGERPENT FOR SUSAN KENT, CITY LIBRARIAN FOR THE LOS ANGELES PUBLIC LIBRARY. JOAN OUDERKIRK IS BEING REPRESENTED BY DAVE LAVERSON FOR THE DIRECTOR OF THE L.A. COUNTY AND INTERNAL SERVICES DEPARTMENT. WE HAVE SANDY CHOU, SENIOR ACCOUNT MANAGER FOR S.B.C. MARGARET TODD, OUR L.A. COUNTY LIBRARIAN. AND JANET BARRY, CITY CLERK FOR THE CITY OF WEST COVINA. SO YOU WANT TO DO A GROUP PICTURE? OKAY. YVONNE AND ZEV AND DON? AND NOW WE HAVE A LITTLE BOY WHO IS ONE YEAR OLD, A CHIHUAHUA MIX WHO'S LOOKING FOR A HOME. HIS NAME IS SPENCER. SPENCER IS BIG ON THE MIX, LITTLE ON THE CHIHUAHUA. HI, SPENCER? HOW ARE YA? ANYWAY, ANYBODY WHO'D LIKE TO ADOPT SPENCER, HE'S ONE YEAR OLD, HE'S LOOKING FOR A HOME, YOU CAN CALL AT HOME IF YOU'RE WATCHING THE TELEVISION AREA CODE 562-728-4644, SPENCER CAN BE YOURS, OR ANYBODY IN THE AUDIENCE WHO'D LIKE TO ADOPT SPENCER. ANYBODY OUT THERE? HUH? THIS IS LITTLE SPENCER. 

SUP. BURKE, CHAIR: I BELIEVE SUPERVISOR MOLINA IS UP FIRST FOR SPECIALS. IS SUPERVISOR MOLINA... ALL RIGHT. IF NOT, WE CAN GO -- ALL RIGHT. WHILE SHE'S COMING, I WANT TO RECOGNIZE THE AFRICAN COMMUNITY RESOURCE CENTER AND ISAAC TESTOSTESTUZE IS HERE. WE ARE GREAT SUPPORTERS OF THEM AND THE SENIORS ARE HERE. WE'RE GOING TO ASK YOU TO STAND UP SO THAT WE CAN RECOGNIZE YOU. [ Applause ] 

SUP. BURKE, CHAIR: THANK YOU FOR COMING DOWN. PLEASE OBSERVE OTHER MEETING. WE'D LOVE TO GIVE YOU TIME TO SPEAK BUT WE HAVE TO DO THAT IN PUBLIC COMMENT AND I DON'T THINK YOU PROBABLY WANT TO WAIT, BUT IF YOU'RE STILL HERE, WE'LL RECOGNIZE YOU THEN SO THAT SOMEONE CAN MAKE A PRESENTATION, BUT AT THIS TIME WE WANT TO THANK YOU FOR ALL YOUR HARD WORK AND WE CERTAINLY APPRECIATE THE CENTER AND WHAT YOU'RE DOING. ALL RIGHT. SUPERVISOR MOLINA. 

SUP. MOLINA: HI, THIS IS FOR SPECIALS NOW? 

SUP. BURKE, CHAIR: YES. 

SUP. MOLINA: ALL RIGHT. FIRST OF ALL, LET ME BEGIN WITH AN ADJOURNMENT. THIS IS AN ADJOURNMENT IN THE NAME OF ONE OF OUR COUNTY EMPLOYEES. I'M ASKING THAT WE ADJOURN IN THE MEMORY OF CHRIS RAMSTEAD. HE PASSED AWAY UNEXPECTEDLY. WHAT I'D LIKE TO DO IS I'D LIKE TO READ AN E-MAIL THAT ONE OF MY STAFF MEMBERS SENT TO THE OTHER STAFF IN MY OFFICE. IT'S FROM ALVIN BUT AND IT WENT TO EVERYONE IN MY OFFICE, AND IT SAYS: "AS I SIT HERE WRITING THIS E-MAIL IT IS WITH A HEAVY SAD AND HEAVY HEART THAT I REPORT THAT CHRIS RAMSTEAD, ROAD MAINTENANCE SUPERVISOR FOR THE DEPARTMENT OF PUBLIC WORKS DIED LAST NIGHT OF A MAJOR HEART ATTACK. ANYONE WHO HAS WORKED WITH CHRIS KNOWS THAT HE AND HIS STAFF WAS INSTRUMENTAL IN MAKING THE COUNTY AND US LOOK GOOD. HE WAS ONE OF THE MOST RESPONSIVE PERSONS IN AND OUT OF THE COUNTY THAT I'VE EVER MET. HIS ATTITUDE WAS NEVER "THIS IS NOT MY JURISDICTION"; RATHER, "LET ME TAKE THIS PROBLEM OFF YOUR HAND AND I'LL GET IT TO THE RIGHT PERSON." OR HE WOULD SAY, "I CAN'T DO IT THAT WAY, BUT LET ME FIGURE OUT ANOTHER WAY TO SOLVE THIS PROBLEM." AND HE WOULD. HE AND HIS CREW WERE ONE OF THE DIVISIONS THAT I NEVER HAD TO MONITOR. MOST OF US IN THE FIELD KNOW CHRIS PERSONALLY AND WE KNOW THAT WITH HIS BOSS, THE LEVEL OF COUNTY SERVICES IN OUR COMMUNITIES WILL BE CHANGED. HE WAS A TRUE PUBLIC SERVANT. SO I'D LIKE TO ASK THAT IF ALL OF US AS MEMBERS OF THE BOARD WOULD ADJOURN IN CHRIS RAMSTEAD'S MEMORY. HE WAS ONLY 50 YEARS OLD. 

SUP. KNABE: HE WAS AN INCREDIBLE INDIVIDUAL, LIKE YOU SAY HE WORKED WITH OUR OFFICE SO CLOSELY ON A NUMBER OF PARTICULARLY UNINCORPORATED AREAS AND HE WILL TRULY BE MISSED AND WHAT A SHOCK. 

SUP. MOLINA: YEAH, IT WAS SHOCKING, AND SO IT'S A SAD PASSING. I'D LIKE TO ALSO ASK THAT WE ADJOURN IN THE MEMORY OF DANIEL SANCHEZ. HE RECENTLY PASSED AWAY. MR. SANCHEZ IS THE GRANDFATHER OF MY STAFF MEMBER, LUPE DELLA TORRE. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO THE ENTIRE FAMILY. AND THEN I'D LIKE TO HAVE A MOTION THAT IS INTRODUCED BY MYSELF AND SUPERVISOR ANTONOVICH. AND THIS MOTION COMES FROM -- I CAN'T REMEMBER THE WOMAN'S CASE, THE WOMAN WHO HAD COME AND WAS DISAPPOINTED ABOUT THE ADOPTION IN PUERTO RICO, AND SO WE HAD ASKED SENATOR MARTEZ GUTIERREZ IF SHE'D CARRY SOME LEGISLATION WITH REGARD TO IT. AND THIS IS A MOTION. THE GOAL OF THE DEPENDENCY SYSTEM IS TO END THE UNCERTAINTY OF FOSTER CARE AND PROVIDE A CHILD WITH A STABLE AND PERMANENT HOME. AT TIMES THIS GOAL IS DIFFICULT TO ACHIEVE WHEN THERE ARE COMPETING PROSPECTIVE CARETAKERS WHO WANT TO PROVIDE A CHILD WITH A PERMANENT PLACEMENT. GENERALLY A DEPENDENCY APPEAL INVOLVING PLACEMENT ORDERS CAN TAKE A YEAR OR MORE TO COMPLETE. SUCH APPEALS MAY CAUSE EMOTIONAL TRAUMA TO A CHILD, AN UNNECESSARY REPLACEMENT OF A CHILD AND ULTIMATELY A SERIOUS DELAY IN ACHIEVING PERMANENCE FOR THAT CHILD. SENATE BILL 59 AUTHORED BY SENATOR MARTEZ GUTIERREZ REDUCES THE DELAYS AS WELL AS OTHER NEGATIVE EFFECTS CAUSED BY APPEALS FROM ORDERS THAT DETERMINE THE PLACEMENT OF DEPENDENT CHILDREN. SB-59 REQUIRES END REVIEW OF ANY SUCH PLACEMENT ORDER AFTER THE DISPOSITION HEARING TO BE BY PETITION FOR EXTRAORDINARY WRIT RATHER THAN BY APPEAL. IF REVIEWED ON THE MERITS, SUCH A WRIT IS NORMALLY COMPLETED IN THREE MONTHS. THIS SHORTENED TIME FRAME WOULD BETTER SERVE DEPENDENT CHILDREN. SPECIFICALLY A PROMPT RESOLUTION OF THESE PLACEMENT ISSUES WOULD RECEIVE PERMANENCE FOR A CHILD WHILE MINIMIZING ANY TRAUMA. I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS SUPPORT SENATE BILL 59, SEND A FIVE SIGNATURE LETTER TO THE SENATE JUDICIARY COMMITTEE, THE LOS ANGELES COUNTY DELEGATION, SENATOR MARTEZ GUTIERREZ AND DIRECTOR KENNY LAVEZ TO HELP ENSURE ITS PASSAGE. AND SO I HAVE THAT FOR NEXT WEEK. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. MOLINA: AND THEN THE ONLY ITEM THAT I THINK I'VE HELD, AND MS. BURKE, YOU'VE HELD IT AS WELL, IS ITEM NUMBER 38. AND I WANTED TO ASK SOME QUESTIONS OF D.P.S.S. I DON'T KNOW WHO IS HERE TO RESPOND TO THESE ISSUES, IT MIGHT JUST BE YOU, DAVE. 

 C.A.O. JANSSEN: NO, BRYCE IS HERE. 

SUP. MOLINA: BRYCE IS HERE, ALL RIGHT, AS I UNDERSTAND THIS IS AN OLD ISSUE THAT HAS BEEN AROUND FOR A WHILE. THE PEOPLE WHO ARE UNFORTUNATELY DEPENDENT ON OUR WELFARE SYSTEM HAVE ALWAYS HAD A PROBLEM IN CASHING CHECKS. MORE RECENTLY, WE HAVE FOUND THAT SOME OF THE CHECK-CASHING AGENCIES WILL CERTAINLY TAKE THEM, BUT IT'S ALWAYS COST THEM A FEE, AND THE MINIMAL DOLLARS THAT THEY RECEIVE SHOULDN'T BE PUT IN THAT KIND OF SITUATION. BUT I THINK WHAT'S MOST TROUBLING OF ALL IS WE HAVE CERTAIN BANKS THAT ARE JUST NOT WILLING TO HONOR SOME OF THESE CHECKS AND UNLESS THERE IS A LARGE FEE, AND I THINK THAT'S A SHAME. WE HAD HAD THIS INCIDENT MANY YEARS AGO IN WHICH WELLS FARGO DIDN'T WANT TO PARTICIPATE, I REMEMBER SENDING THEM A LETTER AND THEY BASICALLY WROTE ME BACK AND SAID, "TOUGH LUCK." WHAT'S DISAPPOINTING TO ME IS IT'S MY UNDERSTANDING THE COUNTY OF LOS ANGELES PROBABLY PUTS IN L.A. COUNTY BANKS ALL OVER THE PLACE IN ALL THESE DIFFERENT BANKS MUCH OF ITS $16 BILLION OR IT PASSES THROUGH THOSE HANDS -- RIGHT, DAVID? AND THERE'S NOTHING WE CAN DO ABOUT IT? RIGHT? WE WASN'T GO TO WELLS FARGO AND SAY, "LET'S GET OUR MONEY OUT OF HERE." IS THAT CORRECT? WE CAN'T DO THAT RIGHT? 

C.A.O. JANSSEN: NO I, ACTUALLY, I DO THINK YOU HAVE SOME FLEXIBILITY ON WHERE YOU PUT YOUR MONEY. 

SUP. MOLINA: REALLY? 

C.A.O. JANSSEN: YEAH. IT'S NOT EASY BUT, IT'S NOT AN EASY THING TO DO, BUT I THINK YOU CAN. 

SUP. MOLINA: WELL, THE REASON IS IS THAT THAT I THOUGHT THAT MAYBE THE REASON WE HAD DELAYED IT FOR TWO WEEKS IS THAT I THOUGHT WE COULD WRITE A LETTER TO SOME OF THESE BANKS AND SAY, "WE MIGHT HAVE TO DO SOMETHING LIKE THIS," BECAUSE I THINK THAT THIS IS AN UNFORTUNATE SITUATION AND MANY OF THESE BANKS PROBABLY DON'T EVEN HAVE BRANCHES IN SOME OF THE AREAS WHERE MOST OF THE DEPENDENT FOLKS OF THESE WELFARE CHECKS ARE AT. BUT I THINK WHAT'S SHAMEFUL ABOUT IT IS THAT THEY CERTAINLY WILL LOBBY US ALL DAY LONG TO GET OUR MONEY THROUGH THEIR BANKS AND ALL KINDS OF OTHER PROCESSES, AND I THINK IT'S A TWO-WAY STREET, AND THEY SHOULD BE COOPERATIVE WITH US AS WELL. I WOULD LIKE AT FIRST THAT WE WOULD SEND THEM A LETTER AND LETTING THEM KNOW THAT WE WOULD LIKE THEM TO COME AND JOIN US IN TWO WEEKS TO MAYBE EXPLAIN TO THE BOARD OF SUPERVISORS AS TO WHY THEIR POLICIES ARE TO CHARGE US -- CHARGE THESE PEOPLE WHO ARE GETTING A MINIMAL CHECK, THESE FEES, AND TO SEE IF THERE'S SOME WAY THAT THEY CAN BE MORE COOPERATIVE BECAUSE IT CAN MOUNT UP. WE UNDERSTAND THERE ARE TWO BANKS OR MAYBE THREE BANKS -- BRYCE, HELP ME HERE -- WHO HAVE LOOKED AT THEIR OWN POLICIES AND FIGURED THAT I THINK WASHINGTON MUTUAL IS ONE OF THE BANKS THAT IS NOT GOING TO CHARGE A FEE? 

BRYCE YOKOMIZO: SUPERVISOR, THAT'S CORRECT. WE HAVE WASHINGTON MUTUAL, WE HAVE CAL FED AND ALSO CITIBANK WHO AGREED NOT TO CHARGE OUR PARTICIPANTS FEES. 

SUP. MOLINA: WELL AND I THINK THAT THAT'S SOMETHING THAT WE SHOULD ALSO APPLAUD AS WELL, THAT WE SHOULD PROBABLY ASK THOSE BANK REPRESENTATIVES TO COME AND WE SHOULD CONGRATULATE THEM. MAYBE WE CAN GIVE THEM A FIVE-SIGNATURE CERTIFICATE FOR DOING THAT, BECAUSE I DO THINK IT'S SOMETHING THAT'S IMPORTANT. SO THE REASON THAT I WANTED TO CONTINUE IT FOR TWO WEEKS IS I WANT TO ASK IF DAVID CAN HELP ME GET THEIR ATTENTION SO THAT THEY CAN COME NEXT WEEK. DAVID? I THOUGHT MAYBE YOU COULD HELP ME, BECAUSE I KNOW THAT IF I WRITE THEM A LETTER TO SHOW UP, THE REPRESENTATIVE TO THE REPRESENTATIVE TO THE ASSISTANT REPRESENTATIVE WILL BE HERE AND THEY'LL SAY, "GEE, I DON'T KNOW WHY THEY HAVEN'T DONE IT." I THOUGHT MAYBE YOU COULD GET THE KEY PERSON TO COME AND SHOW UP IN -- NEXT WEEK AND EXPLAIN WHY THEY MADE THIS DECISION. YOU KNOW, LIKE A DECISION MAKER, AND SAYING THAT THE BOARD MAY WANT TO TAKE A DIFFERENT ACTION ABOUT THEIR MONEY. THESE ARE AGAIN DECISIONS THAT -- I MEAN, AGAIN, I DON'T KNOW WHAT ACTION THE BOARD WILL TAKE, I'M GUESSING, BUT I GUESS I'D LIKE THE REAL PEOPLE TO COME, NOT THE ASSISTANT TO THE ASSISTANT TO THE ASSISTANT FIELD REP. SO IS IT POSSIBLE YOU COULD DO THAT AND GET THEM HERE NEXT WEEK? 

C.A.O. JANSSEN: WE'LL MAKE EVERY ATTEMPT TO DO SO, AND IF THEY DON'T, THAT WILL TELL YOU SOMETHING ABOUT THE BANK AS WELL. 

SUP. MOLINA: I THINK SO, AND I THINK WE'D LIKE TO BE ABLE TO DO THAT, AND I THINK, BRYCE, IF WE COULD ALSO PROBABLY GET YOU TO PARTICIPATE AS WELL, I THINK THAT YOU'VE MADE EFFORTS WITH MANY OF THESE BANKS AND UNFORTUNATELY HAVE NOT RECEIVED THE KIND OF COOPERATION AND MAYBE NEXT WEEK GIVE US A FULL REPORT OF THE KIND OF EFFORT THAT YOU MADE TO EACH OF THEM AS FAR AS TRYING TO LET THEM KNOW SOME OF THE PROBLEMS THAT WE'VE HAD WITH MANY OF OUR RECIPIENTS WHO ARE GETTING THESE SMALL CHECKS AND THESE FEES ARE JUST SO OUTRAGEOUS. SO THAT'S WHY I WANTED TO CONTINUE IT FOR A WEEK. 

SUP. BURKE, CHAIR: RIGHT AND I JUST HAVE AN AMENDMENT THAT WOULD REQUEST THAT THE DIRECTOR EXAMINE THE FEASIBILITY OF APPLYING FOR A FEDERAL WAIVER TO IMPLEMENT A PROGRAM THAT WOULD ALLOW HOMELESS, ELDERLY AND DISABLED PUBLIC ASSISTANCE PROGRAM PARTICIPANTS TO PURCHASE PREPARED FOOD WITH FOOD STAMPS. I UNDERSTAND THAT THERE ARE SOME COUNTIES THAT DO THAT, BUT SUPERVISOR MOLINA, I AGREE WITH YOU TOTALLY. I REMEMBER WHEN WELLS FARGO ACQUIRED FIRST INTERSTATE. FIRST INTERSTATE HAD BEEN THE PEOPLE WHOSE CHECK -- WHO PROVIDED THE CHECKS FOR D.P.S.S. WHEN WELLS FARGO ACQUIRED THEM, THEY PULLED OUT. I MET WITH MR. WATSON AND WITH SOME OF THE PEOPLE FROM WELLS FARGO BECAUSE FIRST INTERSTATE DID ALLOW YOU TO COME IN, BUT THEY SAY THERE WERE SO MANY PEOPLE WHO CAME IN ON THE 1st THAT IT CLOSED DOWN THEIR BANK LITERALLY. BUT WE HAD THOSE CONVERSATIONS WITH THEM. THEY WERE NOT INTERESTED AND I'M SURE THAT'S THE REASON WHY WE WENT OUT OF STATE TO GET A BANK, BUT TODAY IT'S A DIFFERENT SITUATION. WE'RE TALKING ABOUT THESE CHECKS THAT THEY CERTAINLY SHOULD BE ABLE TO HONOR AND SHOULD -- AND COMPETITION'S THE BEST THING. IF WASHINGTON MUTUAL SAYS THEY WON'T CHARGE A FEE, I THINK YOU'LL FIND SOME OF THESE OTHERS STEPPING UP TO THE PLATE, AND I WOULD SUGGEST THAT YOU DO CALL SOME OF THOSE PEOPLE. I THINK THAT'S THE GREATEST IDEA IS TO FIND OUT WHY THEY'RE NOT DOING IT. 

SUP. KNABE: MADAM CHAIR? MADAM CHAIR, JUST TO ADD TO THAT, I BELIEVE THE WELLS FARGO INDIVIDUALS AS WELL AS B.F.A. WERE DOWN HERE SOLICITING SUPPORT FOR THOSE MEXICAN CONSULATE I.D.s FOR DEPOSITS, THAT THEY WERE SECURING DEPOSITS, I WOULD THINK THAT WE MIGHT REMIND THEM OF THAT AS WELL. 

SUP. BURKE, CHAIR: AND MANY OF US WERE OVER THERE WHEN THEY HAD THEIR CELEBRATION AND THEIR ANNIVERSARIES, AND WE HAVE BEEN VERY SUPPORTIVE OF THEM EVEN THOUGH THEY HAVE NOT BEEN SUPPORTIVE OF THE COUNTY, AND THEY'VE HAD EVERY OPPORTUNITY EVEN TO PARTICIPATE IN TERMS OF THE ELECTRONIC TRANSFERS, SO I WOULD, I THINK IT'D BE CERTAINLY WORTHWHILE. 

SUP. ANTONOVICH: MADAM CHAIR, LET ME JUST WELCOME BRYCE BACK AFTER HAVING SURGERY ON HOW WELL HE LOOKS AND WE'RE VERY PLEASED THAT HE'S BACK ON THE JOB AND LOOKING SO YOUNG. 

BRYCE YOKOMIZO: I APPRECIATE THAT SUPERVISOR. THANK YOU ALL, THE ENTIRE BOARD THANKS VERY MUCH. 

SUP. BURKE, CHAIR: AND WE'LL BE VERY NICE TO YOU SO YOU DON'T GET SICK. 

SUP. MOLINA: WELL THAT DEPENDS. 

SUP. ANTONOVICH: AND HOLY CROSS DID A GOOD JOB, NOW YOU'RE GOING TO BE A POSTER BOY FOR HOLY CROSS. 

 BRYCE YOKOMIZO: RIGHT. THERE YOU GO, THANKS. 

SUP. ANTONOVICH: VERY GOOD, THANK YOU, BRYCE. WE APPRECIATE IT. 

SUP. MOLINA: THANK YOU. THE NEXT ITEM I HAVE, SUPERVISOR, IS ITEM 64. SOME OF YOU HAVE BEEN READING, I GUESS, IN THE L.A. TIMES, PARTICULARLY TODAY'S STORY ABOUT THE SITUATION OUT IN SOUTHGATE. 

SPEAKER: [ Inaudible ]. 

SUP. MOLINA: OH. 

SUP. BURKE, CHAIR: I'M GLAD SOMEONE'S PUSHED COMPTON OFF THE FRONT PAGE. 

SUP. MOLINA: YEAH IT IS AMAZING WHAT'S GOING ON OUT THERE, BUT THE COMMUNITY HAS MADE SOME VERY SIGNIFICANT DECISIONS ON BEHALF OF ALL OF ITS RESIDENTS, OR AT LEAST THE VOTERS DID, AND SO CONSEQUENTLY, OUR ACTION HERE TODAY IS THAT AS QUICKLY AS WE PASS THIS ACTION WHICH CREATES A CERTIFICATION OF THE VOTE, IT IS MY UNDERSTANDING THEY WILL BE SWEARING IN EACH OF THE NEW -- EACH OF THE NEW MEMBERS THAT WERE ELECTED UNDER THE RECALL. AND IT SEEMS FROM WHAT WE READ IN THE PAPER THIS MORNING, THAT THAT CAN'T HAPPEN FAST ENOUGH. SO AGAIN, IT MAY CONTINUE TO HAVE MORE CONTROVERSY AS IT CONTINUES TO MOVE THROUGH THE PROCESS, BUT THE CITY DID TAKE ITS ACTION, THEY DID HAVE THE VOTE. THOSE FOLKS WERE DULY ELECTED AND IN THE RECALL, AS WE UNDERSTAND, AS QUICKLY AS WE CERTIFY THIS ELECTION, THEY ARE ENTITLED TO BE SWORN IN AS MEMBERS AND TO TAKE THEIR -- AND TAKE THEIR PROPER PLACE ON THAT CITY COUNCIL. SO THAT'S WHY I'M ASKING THAT WE SWIFTLY ACCEPT THIS RECOMMENDATION AND MOVE IT FORWARD. 

SUP. BURKE, CHAIR: I'LL SECOND THAT. I UNDERSTAND GENEVIEVE CLAVREUL HAS ASKED TO SPEAK. SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: MR. PELLMAN, SOME OF THE PEOPLE FROM SOUTHGATE ASKED THE QUESTION, WOULD NOT THE NEW COUNCIL HAVE THE ABILITY TO RESCIND ANY ACTION OF THESE MULTI--MILLION-DOLLAR CONTRACTS THAT THE OLD COUNCIL WOULD BE APPROVING OR HAS APPROVED AS OF LAST NIGHT? 

COUNSEL PELLMAN: I THINK YOU'RE PROCEEDING SUPERVISOR ON THE BASIS OF RECONSIDERATION AS THE PERSON NOT BEING PRESENT. IT MAY DEPEND UPON THE PARTICULAR CONTRACTS. IT COULD BE TRUE IN SOME CIRCUMSTANCES, BUT IT MAY NOT NECESSARILY BE TRUE IN ALL DEPENDING UPON THE TIME LINES FOR VARIOUS CONTRACTS THAT WERE REQUIRED TO BE EXECUTED. 

SUP. ANTONOVICH: THAT WAS THE QUESTION I TOLD HIM I WOULD ASK OUR COUNSEL, IF THEY WOULD HAVE THAT OPPORTUNITY. 

COUNSEL PELLMAN: RIGHT, THERE WERE SOME THAT WERE BLOCKED BY A COURT ORDER YESTERDAY MORNING THAT THEY HAD ON THEIR AGENDA THAT WAS CALLED HASTILY. MOST LIKELY, THE ONES THAT HAD NOT YET BEEN EXECUTED PRIOR TO THE COURT ORDER WOULD BE NOT EFFECTIVE. 

SUP. ANTONOVICH: WOULDN'T THERE BE CAUSE FOR RECONSIDERATION BECAUSE OF THE CIRCUMSTANCES AND THE PUBLIC RECORD THAT LED UP TO THOSE ACTIONS? 

COUNSEL PELLMAN: WELL, THE PUBLIC RECORD ITSELF MIGHT NOT BE CONTROLLING, BUT THE ATTENDANCE AT THE MEETINGS PREVIOUSLY WHERE THEY WERE APPROVED WOULD POSSIBLY PLAY A ROLE DEPENDING UPON WHETHER THEY HAD ADOPTED THEIR RULES REGARDING ROBERT'S RULES OF ORDER, ET CETERA, REGARDING RECONSIDERATION. 

SUP. ANTONOVICH: THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. GENEVIEVE CLAVREUL HAS ASKED TO SPEAK. 

GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. I'M VERY EXCITED TO SEE WHAT SOUTHGATE DID AND I'M VERY GLAD YOU'RE TAKING RAPID ACTION TO MAKE IT HAPPEN, AND I HOPE THE CITIES IN L.A. COUNTY TAKE AN EXAMPLE OF SOUTHGATE THAT NOTHING IS IMPOSSIBLE WHEN YOU CARE. AND I THINK THAT MAY BE A LESSON TO MANY OF YOU. THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. WITHOUT OBJECTION, THAT'S APPROVED. 

SUP. MOLINA: THOSE ARE ALL MY ITEMS. 

SUP. BURKE, CHAIR: I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF THE ASTRONAUTS OF THE SPACE SHUTTLE COLUMBIA. ON SATURDAY, FEBRUARY 1st, THE NATION GRIEVED OVER THE TRAGIC LOSS OF THE SEVEN COURAGEOUS AND DEDICATED CREW MEMBERS ABOARD THE SPACE SHUTTLE COLUMBIA, INCLUDING ISRAEL'S FIRST ASTRONAUT COLONEL INISH RAMONE. AND THE FIRST INDIAN-BORN WOMAN IN SPACE, DR. KALPANA CHALWA. AIR FORCE COLONEL RICK D. ANDERSON AND DR. LAUREL BLAIR, SULTAN CLARKE, CAPTAIN DAVID M. BROWN, LIEUTENANT COLONEL MICHAEL P. ANDERSON AND COMMANDER WILLIAM C. McCOOL DIED TRAGICALLY AS SPACE SHUTTLE COLUMBIA BROKE APART ON ITS REENTRY. THEIR DEDICATION AND DEVOTION TO SPACE EXPLORATION IS AN INSPIRATION TO US ALL AND WE FINELY REMEMBER THESE BRAVE MEN AND WOMEN AND A NUMBER OF THEM HAD CONTACTS OR CONNECTIONS EITHER DIRECTLY OR INDIRECTLY TO LOS ANGELES COUNTY, SO IT'S VERY IMPORTANT THAT WE -- ALL MEMBERS OF THIS BOARD ADJOURN IN THEIR MEMORY. AND CHRISTOPHER G. RAMSTEAD. I'D LIKE TO JOIN SUPERVISOR KNABE IN ADJOURNING IN MEMORY OF CHRISTOPHER G. RAMSTEAD, A 29 YEAR EMPLOYEE WITH THE DEPARTMENT OF PUBLIC WORKS, HE WAS DISTRICT ENGINEER OF ROAD MAINTENANCE DISTRICT 4. HE PASSED AWAY ON JANUARY 29th AFTER SUFFERING A SUDDEN HEART ATTACK, AND SUPERVISOR MOLINA HAS ALSO INTRODUCED THAT. HE'S SURVIVED BY HIS WIFE ERLINDA, HIS SON MICHAEL AND STEPDAUGHTER ANNA MARIE AND STEPSON PETE AND DAUGHTER-IN-LAW SAL. ALL MEMBERS. JAMES WILLARD JACOB, SR. WAS A LONG-TIME RESIDENT OF WILLOWBROOK. HE WAS AN ACTIVE PARTICIPANT IN WILLOWBROOK AREA PROJECT COMMITTEE, HE WAS A DEACON AT MACEDONIA BAPTIST CHURCH FOR NEARLY FOUR YEARS. HE WAS EMPLOYED BY THE CITY OF LOS ANGELES AS A SCENIC FINISHER FROM 1946 TO '76. HE'S SURVIVED BY THREE DAUGHTERS AND ONE SON. SO ORDERED. I'LL CALL UP ITEM NUMBER 26. I UNDERSTAND THAT GENEVIEVE CLAVREUL HAS ASKED TO SPEAK ON THAT ITEM AS WELL, AND THEN MR. .. 

GENEVIEVE CLAVREUL: GOOD MORNING. MANY TIME I HAVE BROUGHT THAT ISSUE OVER AND OVER AGAIN. YOU ALWAYS LET THE SUNSET REVIEW NOT BE DEALT WITH. I HAVE ATTEND SOME OF THE COMMISSION OF THIS COUNTY. THEY ARE POORLY RUN, THEY VIOLATE THE BROWN ACT RIGHT AND LEFT ON A CONSISTENT BASIS, ASKING FOR YOU TO EXTEND THE SUNSET REVIEW IS A BAD DECISION, BUT YOU DO IT ANYWAY EVERY TIME, BUT THIS IS FOR THE RECORD. I THINK IT'S TIME YOU LOOK AT YOUR COMMISSION. IT WILL BE NICE AND YOU LISTEN WHEN THE PUBLIC SPEAK. BUT IT DOES NOT MATTER. I THINK YOU SHOULD REVIEW EACH COMMISSION, YOU SHOULD TEACH YOUR COMMISSIONER TO OBEY THE BROWN ACT. AND THAT WOULD BE MY RECOMMENDATION. 

SUP. BURKE, CHAIR: I'D LIKE TO CALL UP ITEM 66. OR SO MOVED. MOVED BY YAROSLAVSKY, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. ITEM 66, MR. BAXTER. 

PETER BAXTER: MADAM CHAIR, MEMBERS OF YOUR HONORABLE BOARD, MR. JANSSEN, LADIES AND GENTLEMEN, MY NAME IS PETER BAXTER, AND I LIVE AT 1319 INGRAM STREET IN LOS ANGELES. IT IS RESPECTFULLY SUBMITTED THAT SHERIFF LEE BACA, THE TOP LAW ENFORCEMENT OFFICER OF THE COUNTY OF LOS ANGELES, IS USING HIS AUTHORITY AS THE SHERIFF TO RECOGNIZE AND ACCEPT THE NAMING OF COUNTY COURTHOUSES FOR A POLITICAL PURPOSE. MONEY IS PAID IN THE MILLIONS OF DOLLARS TO HAVE A HOSPITAL WING OR A CHAIR AT A UNIVERSITY NAMED FOR A DONOR. IT IS THEREFORE HIGHLY LIKELY THAT SIGNIFICANT SUMS OF MONEY ARE BEING PAID TO ACHIEVE THE NAMING OF A COUNTY COURTHOUSE FOR A SPECIFIC GROUP OR COMMUNITY IN THE COUNTY. THIS HAS NEVER HAPPENED, TO MY KNOWLEDGE, IN ANY OTHER COUNTY IN THE UNITED STATES. IT IS UNLIKELY THAT A JUDGE PRESIDING IN A NAMED COUNTY COURTHOUSE WAS EVEN AWARE OF THE PROPOSED CHANGE UNTIL THE CHANGE WAS CARRIED OUT. IT IS MY BELIEF THAT NAMING A COURTHOUSE IS NOT AUTHORIZED IN EITHER THE CONSTITUTION OF THE UNITED STATES OR IN THE CONSTITUTION OF THE STATE OF CALIFORNIA, ALL OF WHICH IS RESPECTFULLY SUBMITTED. I THANK YOU, MADAM CHAIR. 

SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY MOLINA. WITHOUT OBJECTION, THAT ITEM IS APPROVED. SUPERVISOR YAROSLAVSKY, I'LL TURN IT FOR YOUR SPECIALS. 

SUP. YAROSLAVSKY: MADAM CHAIR, I ASK THAT WE ADJOURN IN THE MEMORY OF TOM NATE, A RESIDENT OF WEST HOLLYWOOD AND A LONG-TIME COMMUNITY VOLUNTEER, WHO PASSED AWAY AT THE AGE OF 52. AND HE WAS A VOLUNTEER FOR OUR DEPARTMENT OF CONSUMER AFFAIRS, THE AMERICAN RED CROSS, LEGAL SERVICES, AMONG OTHERS AND HE'S SURVIVED BY HIS WIFE, JANNETTE AND HIS SON ADAM. MADAM CHAIR I -- 

SUP. KNABE: SO ORDERED. 

SUP. YAROSLAVSKY: HELLO, MR. CHAIR. I WAS HOLDING ITEM 45. I'M GOING TO WITHDRAW MY HOLD ON IT, RELEASE MY HOLD ON IT AND JUST MOVE APPROVAL. 

SUP. KNABE: I HAD A -- 

SUP. YAROSLAVSKY: ARE THERE OTHERS WHO WANT TO BE HEARD? 

SUP. KNABE: NO, I DON'T THINK SO. IS THERE ANYONE ELSE ON 45? 

SUP. YAROSLAVSKY: ALL RIGHT. MOVE APPROVAL ON 45. 

SUP. KNABE: OKAY, SECONDED. WITHOUT ANY OBJECTION, SO ORDERED. 

SUP. YAROSLAVSKY: I WANT TO READ A MOTION, AND I DON'T KNOW WHETHER WE CAN APPROVE IT TODAY OR WHETHER IT HAS TO GO ON TO NEXT WEEK BUT IT'S, BILL YOU CAN GIVE ME SOME HELP ON THIS, IN 2001 THE UNITED STATES VENDORS ADMINISTRATION INITIATED A PROCESS THAT LED TO THE CREATION OF ITS 25-YEAR PLAN FOR FURTHER DEVELOPMENT OF THE VETERANS ADMINISTRATION PROPERTY IN THE UNINCORPORATED AREA OF WEST LOS ANGELES. THE IMPACTS OF THE INTENSE DEVELOPMENT ENDORSED BY THIS PLAN ON THE SURROUNDING NEIGHBORHOODS WERE SO UNSUSTAINABLE THAT THE BOARD ADOPTED A MOTION WITH SEVERAL PROVISIONS ALL INTENDED TO RESTRAIN SUCH DEVELOPMENT WITHOUT ADEQUATE CONSIDERATION AND PROPER MITIGATION OF TRAFFIC AND OTHER ENVIRONMENTAL IMPACTS. WHILE THE PLAN FOR A MASSIVE COMMERCIAL DEVELOPMENT IN THIS AREA SEEMS TO BE IN ABEYANCE, IT HAS COME TO MY ATTENTION THAT THE UNITED STATES ARMY HAS ENTERED INTO NEGOTIATIONS TO TRANSFER ITS 10.8-ACRE PROPERTY ADJACENT TO THE VENDORS ADMINISTRATION OTHERWISE KNOWN AS THE ARMY RESERVE CENTER, TO A PRIVATE DEVELOPER FOR DEVELOPMENT. THE SUBJECT PROPERTY IS ZONED R4, WHICH IS UNLIMITED RESIDENTIAL WHICH PERMITS UP TO 50 UNITS HER ACRE, THE HIGHEST DENSITY IN ANY ZONE IN THE COUNTY. THIS ZONE ALLOWS A NUMBER OF POTENTIALLY MORE INTENSE USES BY CONDITIONAL USE PERMIT INCLUDING HOTELS AND UNIVERSITIES. THE ZONING DESIGNATION FOR THIS AREA WAS ESTABLISHED IN THE EARLY 1900s IN ORDER TO ACCOMMODATE VETERANS HOUSING ON THE V.A.s PROPERTY, SPECIFICALLY FOR THE OLD SOLDIERS' HOME AND LIKE USES. THE COUNTY ZONING ON THIS AND ADJACENT FEDERALLY OWNED LANDS HAVE NOT BEEN REEVALUATED IN ALL THESE DECADES. IN LIGHT OF THE POTENTIAL TRANSFER OF THIS PUBLICLY-OWNED LAND TO PRIVATE OWNERSHIP FOR PRIVATE DEVELOPMENT, AND IN LIGHT OF THE FACT THAT THIS AREA IS ONE OF THE MOST INTENSELY DEVELOPED AND HEAVILY TRAFFICKED AREAS OF THE COUNTY, A REVIEW IS IN ORDER. INDEED IT WOULD BE PRUDENT TO UNDERTAKE A COMPREHENSIVE LOOK AT THE LAND USE REGULATORY STRUCTURE OF THIS UNINCORPORATED AREA, INCLUDING THE VENDORS ADMINISTRATION ITSELF. I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS REQUEST THE DIRECTOR OF PLANNING AND THE REGIONAL PLANNING COMMISSION WITH SUPPORT FROM OTHER COUNTY DEPARTMENTS AS NECESSARY TO INITIATE A ZONING STUDY FOR THE VENDORS ADMINISTRATION AND ARMY RESERVE PROPERTIES IN WEST LOS ANGELES AND TO COORDINATE WITH THE FEDERAL GOVERNMENT AND THE CITY OF LOS ANGELES FOR THE PURPOSE OF DETERMINING THE APPROPRIATE ZONING AND TO ENSURE THAT FURTHER PRIVATE DEVELOPMENT IN THIS AREA IF THERE'S TO BE ANY, IS SENSITIVE TO AND COMPATIBLE WITH SURROUNDING NEIGHBORHOODS AND TO PROVIDE A PROGRESS REPORT TO THE BOARD IN 120 DAYS. CAN WE GO AHEAD AND INITIATE THIS STUDY TODAY? 

MR. PELLMAN: I DON'T WANT TO SOUND PICKY, SUPERVISOR, BUT IF YOU'LL SLIGHTLY MODIFY IT AND JUST -- WE'RE NOT GOING TO BE DOING THE ZONING STUDY, YOU'RE GOING TO BE ASKING FOR A REPORT BACK FROM. 

SUP. YAROSLAVSKY: AND I WANT TO INITIATE A ZONING STUDY, SO IF THAT'S GOT TO GO OVER A WEEK, THEN WE'LL JUST DO IT NEXT WEEK. OKAY THEN THIS WILL BE FOR NEXT WEEK. THAT'S ALL I HAVE, MR. CHAIRMAN. 

SUP. KNABE: OKAY, MADAM CHAIR, I HAVE SOME ADJOURNMENTS AS WELL. I MOVE THAT WE ADJOURN IN MEMORY OF OLA SIMS, WHO PASSED AWAY LAST WEEK. SHE'S SURVIVED BY HER DAUGHTER NANCY PIAZZA, AND SON RICHARD SIMS, GRANDCHILDREN KEITH, VICKI, ROBERT AND MELISSA AND GREAT-GRANDCHILDREN HANNAH, DYLAN AND ALLISON. JOIN IN THE MEMORY ALSO OF THE COLUMBIA ASTRONAUT CREW. ALSO THAT WE ADJOURN IN MEMORY OF DR. ROBERT BACON, AN EDUCATOR AT HARBOR COLLEGE AND DEAN AT THE LOS ANGELES CITY COLLEGE. HE'S A 50-YEAR RESIDENT OF THE PENINSULA AND IS SURVIVED BY HIS WIFE OF 54 YEARS, HELEN. ALSO THAT WE ADJOURN IN MEMORY OF MR. TONG SE CHIN, FORMER TREASURER OF THE INTERNATIONAL RESCUE COMMITTEE, AND THE INTERNATIONAL INSTITUTE OF LOS ANGELES. HE WAS A VOLUNTEER AT THE REFUGE FORUM OF LOS ANGELES COUNTY. ALSO THAT WE ADJOURN IN MEMORY OF JOSEPH ESTRADA, A LONG-TIME RESIDENT OF LOS ANGELES COUNTY WHO DIED RECENTLY AT THE AGE OF 90. AND HE'S SURVIVED BY HIS FOUR CHILDREN AND GREAT GRANDCHILDREN. ALSO THAT WE ADJOURN IN MEMORY OF GERALD GOLDBERG. HIS GREATEST QUALITY AS ADMINISTRATOR OF THE PACIFIC HOSPITAL IN LONG BEACH WAS HIS ABILITY TO BRING PEOPLE TOGETHER. HE'S SURVIVED BY HIS WIFE JANINE, NIECES SARAH, JANET, MELISSA AND CHERYL. ALSO THAT WE ADJOURN TODAY IN MEMORY OF BARBARA HAMILTON, A BLUFF HOSPICE NURSE PRAISED FOR HER COMPASSIONATE CARE OF THE TERMINALLY ILL. SHE'S NOTED FOR BECOMING LIKE A PATIENT'S FAMILY. SHE'S SURVIVED BY HER DAUGHTER BARBARA, TWO SONS, DONALD AND KENNETH. ALSO THAT WE ADJOURN IN MEMORY OF BERNARD HARVEY, A FACULTY MEMBER AT CAL STATE LONG BEACH FOR 36 YEARS, SURVIVED BY HIS WIFE MICHELLE. ALSO THAT WE ADJOURN IN MEMORY OF IRVING ISBELL. JIM IS THE WHAT'S COMMONLY KNOWN AS THE BELOVED HUSBAND OF L.A. COUNTY'S FORMER ASSISTANT DIRECTOR OF EMERGENCY MEDICAL SERVICES, DARLENE ISBELL, WHO PASSED AWAY LAST WEEK AT THE AGE OF 56. ALSO THAT WE ADJOURN IN MEMORY OF ANNETTE KELEHER, A LONG-TIME RESIDENT OF ROLLING HILLS ESTATES. SHE WAS A RETIREE OF THE AEROSPACE CORPORATION. SHE IS SURVIVED BY HER CHILDREN MICHAEL, PATRICIA AND SHAWN, AND HER GRANDCHILDREN, SHAWN AND KAITLYN. ALSO THAT WE ADJOURN IN MEMORY OF NOBLE MAC McTAGGERT, HE IS THE FATHER OF RANCHO PALOS VERDES COUNCILMAN, CURRENTLY PRESIDENT OF CONTRACT CITIES JOHN McTAGGERT. MAC WAS A GREAT GUY. HE PASSED AWAY ON SATURDAY AT THE AGE OF 102. ALSO THAT WE ADJOURN IN MEMORY OF RUSSELL NICHOLSON, JR., HE PASSED AWAY AT THE AGE OF 86. A 20 YEAR RESIDENT OF RANCHO PALOS VERDES. ALSO THAT WE ADJOURN IN MEMORY OF ALEXANDER SHEENMENT, A FORMER ROLLING HILLS ESTATES MAYOR, WHO PASSED AWAY ON JANUARY 10th. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. YAROSLAVSKY: MR. CHAIR, MR. KNABE, I FORGOT TO INTRODUCE SOMETHING, WOULD YOU -- FOR NEXT WEEK. 

SUP. KNABE: YES, ALL RIGHT. 

SUP. YAROSLAVSKY: WHEN YOU'RE DONE, OR WHAT? 

SUP. KNABE: WELL I JUST -- YEAH, YOU CAN HAVE IT. I JUST GOT A NOTE HERE. I'LL ONLY INTRODUCE -- I'VE JUST BEEN INFORMED THAT I'M A NEW GRANDFATHER FOR THE SECOND TIME, RAYANN CHRISTIE, 6 POUNDS 9 OUNCES, 20 INCHES LONG. IN THE LAST FEW MINUTES SO. 

SUP. ANTONOVICH: CONGRATULATIONS. 

SUP. BURKE, CHAIR: CONGRATULATIONS! CONGRATULATIONS. [ Applause ] 

SUP. YAROSLAVSKY: THAT'S GOOD. 

SUP. KNABE: IT'S GOOD AND IT'S ALL YOURS. 

SUP. YAROSLAVKSY: 20 INCHES LONG AND WE'LL RECRUIT HER FOR U.C.L.A. BASKETBALL TEAM. 

SUP. KNABE: U.C.L.A., DID YOU SAY? OH NO, NO, NO. 

SUP. YAROSLAVSKY: THAT' WHAT I SAID. MADAM CHAIR, I WANTED TO INTRODUCE THIS MOTION FOR NEXT WEEK. ACTUALLY, IT'S TO SCHEDULE SOMETHING FOR NEXT WEEK, YES. DURING THE PAST YEAR, THERE'S BEEN A SERIOUS AND PERSISTENT OUTBREAK OF A HIGHLY INFECTIOUS SKIN DISEASE CALLED METACILLIN RESISTANT STAPHYLOCOCCUS AUREA, OR M.R.S.A. AMONG THE INMATE POPULATION OF THE SHERIFF'S DETENTION FACILITIES. THE ANALYSIS OF THE OUTBREAK INDICATES THAT APPROXIMATELY 9% OF THE INMATES BECAME INFECTED BEFORE THEIR INCARCERATION. THIS IS A SERIOUS DISEASE. NEARLY A THOUSAND INMATES WERE INFECTED IN 2002 CAUSING 57 TO BE HOSPITALIZED DURING THE FIRST EIGHT MONTHS. THE SHERIFF'S MEDICAL STAFF ARE WORKING CLOSELY WITH THE ACUTE COMMUNICABLE DISEASE CONTROL PERSONNEL IN THE DEPARTMENT OF HEALTH SERVICES ON TREATMENT, CONTROL AND PREVENTION STRATEGIES. COINCIDENTALLY WITH THE DEVELOPMENT OF THE OUTBREAK WITHIN COUNTY JAILS A NUMBER OF MEDICAL PROVIDERS IN THE COMMUNITY BEGAN REPORTING INCREASED OCCURRENCES OF THE DISEASE AMONG THEIR PATIENTS. MANY OF THESE REPORTS HAVE COME FROM PHYSICIANS TREATING H.I.V.-POSITIVE PATIENTS. OUTBREAKS HAVE ALSO OCCURRED IN OTHER SEGMENTS OF THE COMMUNITY. THE FREQUENCY OF THESE REPORTS WITHIN THE COMMUNITY ALONG WITH THE CONTINUING OUTBREAK AMONG THE JAIL POPULATION HAVE BROUGHT D.H.S. PUBLIC HEALTH STAFF TO THE CONCLUSION THAT THE RESPONSE TO BOTH MUST BE COORDINATED AS ONE OVERALL PUBLIC HEALTH PROBLEM. THE M.R.S.A. OUTBREAK IS REMINISCENT OF THE SYPHILIS OUTBREAK TWO YEARS AGO WHICH REFLECTED A SIMILAR INSTITUTIONAL AND COMMUNITY PATTERN. THE D.H.S. PUBLIC HEALTH AND SHERIFF MEDICAL PERSONNEL HAVE INITIATED A NUMBER OF MEASURES TO MANAGE THE OUTBREAK AND PREVENT ANY FURTHER SPREAD OF THE DISEASE. AT THE SAME TIME IT IS IMPORTANT THAT THE BOARD RECEIVE A COMPLETE BRIEFING ON THIS MATTER IN ORDER TO ASSURE THAT SUFFICIENT RESOURCES ARE IN PLACE TO ADDRESS THIS PUBLIC HEALTH THREAT. I THEREFORE MOVE THAT THE BOARD SCHEDULE AS A SET ITEM AT OUR MEETING ON FEBRUARY 11th NEXT WEEK A PRESENTATION OF THE STATUS OF THE M.R.S.A. OUTBREAK ALONG WITH APPROPRIATE RECOMMENDATIONS BY THE DIRECTOR OF THE DEPARTMENT OF HEALTH AND THE SHERIFF'S MEDICAL PERSONNEL. 

SUP. ANTONOVICH: I ALSO HAVE A MOTION. 

SUP. KNABE: ALL RIGHT. DO YOU HAVE -- DO YOU WANT TO READ IN YOUR MOTION? 

SUP. ANTONOVICH: OKAY YEAH, AND FOLLOWING UP ON THAT WE WOULD REQUEST THAT THE SHERIFF TO REPORT BACK ON THE 11th RELATIVE TO THIS OUTBREAK AND ALSO TO REQUEST THEM TO REPORT AT THE FEBRUARY 11th MEETING THE POSSIBILITY OF CONTRACTING OUT TO MEDICAL SERVICES IN THE COUNTY JAIL TO ERADICATE THIS STREP INFECTION, WHICH IS A DEADLY INFECTION. 

SUP. BURKE, CHAIR: ALL RIGHT. AND THAT WILL BE FOR FEBRUARY 11th. 

SUP. ANTONOVICH: NEXT WEEK. 

SUP. BURKE, CHAIR: NEXT WEEK. SO ORDERED. MOVED BY YAROSLAVSKY, AMENDED BY ANTONOVICH, AND SO ORDERED. 

SUP. KNABE: MADAM CHAIR, I HELD SEVERAL ITEMS. FIRST OF ALL, ITEM NUMBER 9. AND BASICALLY ON ITEM NUMBER 9, I HAD AN AMENDMENT. I KNOW THAT SUPERVISOR YAROSLAVSKY AND SUPERVISOR MOLINA HAD SOME CONCERNS, SO I WOULD AMEND IT THERE, I WOULD THEREFORE MOVE THAT THE COUNTY INFORMATION OFFICER IN CONSULTATION WITH THE SERVICE INTEGRATION BRANCH AND INVOLVED COUNTY DEPARTMENTS REPORT ON THE FEASIBILITY OF DEVELOPING A COMPUTER-BASED TRACKING SYSTEM WHICH WILL LIST WHAT STATE AND FEDERAL FUNDS ARE BEING PROVIDED VIA COUNTY DEPARTMENTS, THE AGENCIES AND ORGANIZATIONS THROUGHOUT LOS ANGELES COUNTY IN THE HEALTH AND SOCIAL SERVICES FIELDS AND THAT A REPORT BE PROVIDED IN 90 DAYS. I FURTHER MOVE THAT THIS REPORT INCLUDE A REVIEW OF THE POMONA SERVICE INTEGRATION BRANCH DATABASE PILOT PROJECT. WITH THAT AMENDMENT, I'D MOVE THE ITEM. 

SUP. BURKE, CHAIR: IT'S BEEN MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

SUP. KNABE: ITEM 23, THE FEDERAL AGENDA, I JUST -- I GUESS WE HAVE TO HAVE THIS EACH AND EVERY TIME, BUT I THOUGHT THAT WAS ONGOING, BUT THE THING THAT I WANTED TO ADD TO IT WAS TO CONTINUE TO OPPOSE THE DOWNSIZING AND/OR PLANNED CLOSURE OF THE L.A. AIR FORCE BASE. 

C.A.O. JANSSEN: WE INADVERTENTLY LEFT IT OUT, SUPERVISOR. IT SHOULD'VE BEEN IN THERE. 

SUP. KNABE: OKAY, WITH THAT, I MOVE THE AGENDA. 

CLERK VARONA-LUKENS: AND MADAM CHAIR, FOR THE RECORD, ALSO IN CONNECTION WITH THIS, ON POINT NUMBER 10, SUPERVISOR ANTONOVICH IS ABSTAINING ON THE IMMIGRATION AND REFUGEES, OPPOSE PROPOSALS WHICH WOULD RESTRICT THE ELIGIBILITY OF REFUGEES FOR OTHER FEDERAL PROGRAMS SUCH AS TEMP MEDICAID OR WHICH WOULD SHIFT COSTS OF PROVIDING CASH AND MEDICAL ASSISTANCE TO REFUGEES FROM THE FEDERAL GOVERNMENT TO STATE AND LOCAL GOVERNMENTS. ON POINT NUMBER 6, SUPERVISOR ANTONOVICH, FOR THE RECORD, IS VOTING "NO" UNDER EMPLOYMENT AND TRAINING, THE SUPPORT PROPOSALS WHICH PERMIT FULL IMPLEMENTATION OF THE COUNTY'S LIVING WAGE ORDINANCE. AND THEN ON POINT NUMBER 21, FOR THE RECORD, SUPERVISOR ANTONOVICH VOTES "NO". UNDER CENSUS AND FEDERAL DATA, TO SUPPORT PROPOSALS WHICH PROMOTE ACCURATE, UNBIASED AND INCLUSIVE CENSUS COUNTS AND SUPPORT THE USE OF SCIENTIFICALLY SOUND SAMPLING METHODS TO AUGMENT THE DIRECT COUNT TO ENSURE THAT THE ACCURATE DATA WILL BE AVAILABLE WITH WHICH TO EQUITABLY ALLOCATE FUNDS AMONG STATES AND LOCALITIES. THAT'S FOR THE RECORD. 

SUP. BURKE, CHAIR: ALL RIGHT. SO YOU ARE AMENDING IT, SUPERVISOR KNABE? 

SUP. KNABE: TO INCLUDE THE -- OPPOSE THE DOWNSIZING AND THE PLANNED CLOSURE OF THE L.A. AIR FORCE BASE. 

SUP. BURKE, CHAIR: ALL RIGHT. IT'S MOVED BY KNABE AS AMENDED AND SECONDED BY YAROSLAVSKY. DO YOU WANT TO CALL THE ROLL SO THAT WE CAN SHOW THAT THERE'S AN ABSTENTION? 

SUP. KNABE: I THINK THERE'S AN EXTENSION -- NO VOTES ARE WITHIN THE CONFINES OF IT, HE'S GOING TO VOTE FOR IT OVERALL. BUT WITH THOSE CHANGES INSIDE. 

SUP. ANTONOVICH: JUST THOSE ACCEPTED -- 

SUP. BURKE, CHAIR: YOU'RE GOING TO VOTE FOR IT OVERALL, ALL RIGHT, SO THAT WE'LL -- 

SUP. ANTONOVICH: AS REFLECTED BY THE EXECUTIVE OFFICER. 

SUP. BURKE, CHAIR: WITH THE PARTICULAR ABSTENTIONS -- OR ARE YOU VOTING "NO" ON THOSE? 

SUP. ANTONOVICH: SOME ARE ABSTAINING, SOME ARE "NO", BUT AS REFLECTED -- AS READ BY THE EXECUTIVE OFFICE. 

SUP. BURKE, CHAIR: ALL RIGHT. AS READ BY THE EXECUTIVE OFFICER, SUPERVISOR ANTONOVICH WILL BE RECORDED AS ABSTAINING ON CERTAIN PROVISIONS THAT HE HAS SET FORTH AND VOTING "NO" ON THE OTHER PROVISIONS. 

SUP. ANTONOVICH: WHILE VOTING FOR THE MOTION. 

SUP. BURKE, CHAIR: BUT VOTING FOR THE REMAINDER OF THE MOTION, SO THE MOTION PASSES UNANIMOUSLY EXCEPT FOR THOSE SECTIONS WHERE THERE'S AN ABSTENTION OR VOTING "NO" BY ANTONOVICH AND ON THOSE PORTIONS -- I THINK WE HAVE TO DIVIDE THE QUESTION. DIVIDE THE QUESTION BETWEEN THE REMAINDER -- LET'S JUST DIVIDE THE QUESTION SO IT'LL BE CLEAR. WE'LL DIVIDE THE QUESTION, WE'LL TAKE UP THOSE PORTIONS WHERE SUPERVISOR ANTONOVICH IS ABSTAINING OR VOTING "NO." ON THAT, SUPERVISOR KNABE MOVES AS AMENDED, SECONDED BY YAROSLAVSKY. IT IS ADOPTED 4-TO-1 -- OR 4-TO-0. ON THE REMAINDER, IT'S MOVED BY ANTONOVICH, SECONDED BY KNABE. SO ORDERED. 

SUP. YAROSLAVSKY: COULD YOU REPEAT THAT? [ Light Laughter ]. 

SUP. BURKE, CHAIR: DID YOU GET THAT? 

CLERK VARONA-LUKENS: YES, I HAVE IT. 

SUP. BURKE, CHAIR: WE DIVIDED THE QUESTION. SO ONE PORTION OF IT WAS APPROVED UNANIMOUSLY. THE OTHER PORTIONS ARE APPROVED EITHER 4-TO-1 OR 4-TO-0. ALL RIGHT. YOUR NEXT ITEM, MR. KNABE. 

SUP. KNABE: YES HOPEFULLY THIS WON'T BE QUITE AS CONFUSING BUT ITEM NUMBER 34, I SUPPORT THE ITEM, BUT MY CONCERN IS, YOU KNOW, IS THE DEPARTMENT IS REPORTING THAT DUE TO THE WIDELY-PUB -- PLAN TO CLOSE HIGH DESERT HOSPITAL, THE HOSPITAL IS EXPERIENCING A HIGHER THAN NORMAL ATTRITION RATE AND HAS BEEN UNABLE TO FILL STAFFING VACANCIES FOR CRITICAL PATIENT CARE IN A TIMELY MANNER. OBVIOUSLY WITH OUR VOTE LAST WEEK ON RANCHO, FEBRUARY 26th IS THE DEADLINE FOR MEDICAL STUDENTS TO SUBMIT THEIR APPLICATIONS FOR THE RESIDENCY PROGRAM, AND I THINK THE JOINT COUNCIL OF INTERNS AND RESIDENTS REPORT THE NUMBER OF APPLICANTS IN LOS ANGELES COUNTY IS DOWN DRAMATICALLY, IN SOME CASES BY 30%, AND THE GREATEST IMPACT IS BELIEVED TO BE IN FAMILY MEDICINE, PEDIATRICS AND NOW WITH THE CLOSURE OF RANCHO ORTHOPEDICS. SO I GUESS THE DEPARTMENT -- SOMEONE FROM THE DEPARTMENT COULD -- WHAT ARE WE DOING TO SORT OF MITIGATE THE LOSS OF THESE QUALIFIED APPLICANTS TO OUR MEDICAL TREATMENT PROGRAM? 

DR. THOMAS GARTHWAITE: SUPERVISOR, I THINK THAT THE SOONER WE CAN FINISH OFF OUR NEGOTIATIONS WITH STATE AND FEDERAL GOVERNMENT AND AND SORT OF GIVE PUBLICLY A SENSE OF STABILITY TO THOSE APPLYING, THE BETTER. I TALKED TO ONE OF THE PHYSICIANS AT HARBOR YESTERDAY WHO CALLED ME AS TO WHEN WE MIGHT BE ABLE TO ISSUE SUCH A -- SORT OF A LETTER OF RELATIVE STABILITY, AND I TOLD HIM THAT I ANTICIPATED WE WOULD BE HEARING VERY SHORTLY FROM THE STATE AND FEDERAL GOVERNMENTS. WE THOUGHT WE MIGHT HAVE AN ANNOUNCEMENT AS EARLY AS TODAY, BUT WE HAVEN'T GOTTEN IT QUITE YET, BUT I THINK OPTIMISTICALLY THIS WEEK WE'LL HAVE AN ANNOUNCEMENT AND THAT WILL ALLOW US TO AT LEAST SAY THE LENGTH OF TIME WE THINK THAT THE FEDERAL AGREEMENT WILL ALLOW US TO REMAIN STABLE. AND I THINK YOUR POINT IS ABSOLUTELY WELL TAKEN AND WE'VE PUSHED VERY HARD ON THIS AGREEMENT FOR THAT AND MANY OTHER REASONS SO WE CAN GET A LITTLE DISABILITY OUT THERE AND SO THAT PEOPLE ARE ENTERTAINING COMING TO LOS ANGELES, WILL MAKE THAT CHOICE. 

SUP. KNABE: THANK YOU. 

SUP. YAROSLAVSKY: CAN I ASK A FOLLOW-UP QUESTION? YOU WERE JUST REFERRING -- WERE YOU REFERRING SPECIFICALLY THERE TO -- WELL TO WHICH HOSPITALS WERE YOU REFERRING, I GUESS IS THE QUESTION? 

SUP. KNABE: ALL OF THEM, THAT'S MY QUESTION WAS WITH REGARDS TO ALL OF THEM. 

SUP. YAROSLAVSKY: ARE YOU REFERRING TO HIGH DESERT? 

DR. THOMAS GARTHWAITE: NO, NOT REALLY A TRAINING PROGRAM. 

SUP. YAROSLAVSKY: ARE YOU REFERRING TO RANCHO? 

DR. THOMAS GARTHWAITE: RIGHT, PRIMARILY REFERRING TO HARBOR AND OLIVE VIEW, ALTHOUGH WE'VE TALKED ABOUT WITH MEASURE B THAT LIKELY WE WOULDN'T NEED TO CLOSE THOSE UNTIL SOME OF THE FEDERAL AND STATE NEGOTIATIONS HAVE PROGRESSED AS THEY HAVE. WE REALLY HAVEN'T BEEN ABLE TO ASSURE ANYONE OF THAT EVEN, YET. 

SUP. YAROSLAVSKY: NOW I WANTED TO ASK YOU, THERE WAS AN ARTICLE IN THE OPINION SECTION OF THE L.A. TIMES OVER THE WEEKEND WHICH KIND OF PUZZLED ME 'CAUSE IT MADE REFERENCE TO A STATEMENT THAT YOU ARE ALLEGED TO HAVE MADE WHICH I'VE NEVER HEARD YOU MAKE OR SEEN IT WRITTEN, THAT WITH THE PASSAGE OF MEASURE B, YOU STILL THOUGHT WE HAD TO CLOSE OLIVE VIEW AND HARBOR. DID YOU READ THAT ARTICLE THAT I'M REFERRING TO IN THE OPINION SECTION? 

DR. THOMAS GARTHWAITE: I DID. I DON'T -- I DON'T REMEMBER SAYING -- 

SUP. YAROSLAVSKY: WAS IT JUST AN ERROR ON THE PART OF THE AUTHOR? 

DR. THOMAS GARTHWAITE: YEAH. I DON'T REMEMBER EVER SAYING THAT WITH THE PASSAGE OF MEASURE B THAT WE'D STILL HAVE TO DO THAT. 

SUP. YAROSLAVSKY: RIGHT, I DON'T EITHER. I JUST WANTED TO MAKE SURE I DIDN'T MISS ANYTHING. 

SUP. KNABE: I JUST REMEMBER YOU SAYING IT. I REMEMBER ZEV SAYING IT, I DON'T REMEMBER DR. GARTHWAITE SAYING IT. 

SUP. YAROSLAVSKY: I MAY HAVE SAID IT, BUT THAT'S NOT WHAT THE ARTICLE SAID. I'VE SAID A LOT OF THINGS. OKAY. THANK YOU, DR. GARTHWAITE. 

DR. THOMAS GARTHWAITE: THANK YOU. 

SUP. BURKE, CHAIR: WELL THERE WERE A LOT OF THINGS IN THAT ARTICLE I THINK THAT DO NEED TO BE CLARIFIED AND RESPONDED TO. 

SUP. KNABE: THAT ANSWERS MY QUESTION. YOU WANT TO MOVE THE ITEM, MADAM CHAIR. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

SUP. KNABE: THEN ITEM 35. I GUESS MY QUESTION TO THE C.A.O. IS, DO WE REALLY NEED A NATIONAL SEARCH ON THIS POSITION AS IT, YOU KNOW, IF WE. 

C.A.O. JANSSEN: SUPERVISOR, MIKE HENRY AND I HAVE TALKED ABOUT THIS AND WE DON'T NEED A NATIONAL SEARCH, WE DON'T REALLY NEED TO DO IT WITH A SEARCH FIRM. I THINK MIKE IS CAPABLE OF DOING IT IN CALIFORNIA SPECIFIC WITHOUT HIRING A SEARCH FIRM, AND IF THE BOARD DOESN'T HAVE A PROBLEM WITH THAT, WE'LL WITHDRAW THE ITEM. 

SUP. YAROSLAVSKY: NO. 

C.A.O. JANSSEN: OKAY. 

SUP. YAROSLAVSKY: I THOUGHT IT WAS A GOOD RECOMMENDATION, AND I DON'T THINK IT HURTS US TO GET A NATIONAL SEARCH. THIS IS A VERY IMPORTANT POSITION, AND IN MY PERSONAL OPINION, I THINK YOU OUGHT TO CAST THE NET WIDE AND SEE WHAT YOU GET, AND IF IT MEANS YOU HAVE TO HIRE A FIRM, SO BE IT. BUT I THINK OF ALL THE POSITIONS WE HAVE, I THINK THIS IS A PARTICULARLY IMPORTANT ONE AND IT INVOLVES CONTRACTING AND ALL THAT'S RELATED TO THAT, AND I THINK WE OUGHT TO CAST OUR NET WIDE. I THOUGHT IT WAS A GOOD RECOMMENDATION. I WOULDN'T BACK OFF ON IT, IF I WERE YOU. 

SUP. KNABE: WELL I MEAN MY POINT IS, IS THAT YOU'VE DOWNSIZED, I THINK YOU'VE TAKEN THE POSITION BACKWARDS AND THAT, YOU KNOW, THAT'S THE REASON I WAS ADVOCATING NOT HAVING A NATIONAL SEARCH IS THAT THE RESPONSIBILITY OF THAT POSITION HAS DWINDLED CONSIDERABLY. 

SUP. YAROSLAVSKY: WHICH POSITION ARE WE TALKING ABOUT? I.S.D. 

SUP. KNABE: YEAH. 

SUP. YAROSLAVSKY: I THINK IT'S A PRETTY HEFTY RESPONSIBILITY. AND IT HASN'T BEEN DOWNSIZED SINCE I'VE BEEN HERE, NOT THAT I'M AWARE OF. YEAH BUT CONTRACTING FOR VEHICLES AND CONTRACTING FOR GOODS -- 

C.A.O. JANSSEN: ALL OF THE PURCHASING OF THE COUNTY IS DONE AS WELL AS INFORMATION SERVICES, CENTRAL OPERATION FOR DATA PROCESSING. 

SUP. YAROSLAVSKY: IT'S HUGE, AND... ANYWAY. 

SUP. BURKE, CHAIR: ARE YOU MOVING THE ITEM? 

SUP. KNABE: I JUST DON'T THINK YOU NEED TO WASTE THE MONEY, BUT IF THAT'S WHAT YOU WANT TO DO, THAT'S FINE. 

SUP. BURKE, CHAIR: MOVED. IS THERE A SECOND? I'LL SECOND IT. I'LL CALL THE ROLL. IS THERE ANY DISCUSSION? WELL, I'LL JUST SAY WHY I'M SECONDING IT. I THINK THAT THIS IS A TREMENDOUS RESPONSIBILITY AND WE SHOULD AT LEAST SEE WHO IS AVAILABLE, WHO MIGHT HAVE A NUMBER OF GOOD IDEAS AND APPROACHES TO THIS POSITION. IT'S ONE THAT CARRIES A LOT OF DOLLARS, THEY HAVE CONTROL OVER A LOT OF DOLLARS, AND I WOULD BE MUCH -- I DON'T NECESSARILY SAY THAT YOU HAVE TO HAVE ANY SEARCH FIRM. I WOULD BE WILLING TO AGREE THAT WE CONDUCT A NATIONAL SEARCH IN-HOUSE THAT WE USE, THAT THE DEPARTMENT CONDUCT A NATIONAL SEARCH, BUT I THINK THEY'RE CAPABLE OF PUTTING ADS IN. 

SUP. MOLINA: I'LL SECOND THAT. 

SUP. BURKE, CHAIR: BUT I DO THINK WE SHOULD HAVE A NATIONAL SEARCH. 

SUP. MOLINA: [ Inaudible ]. 

SUP. YAROSLAVSKY: MIKE, DO YOU THINK YOU CAN HANDLE IT? 

SUP. BURKE, CHAIR: CAN YOU DO THIS? HE'S DONE IT IN OTHER CASES. 

MICHAEL J. HENRY: YES, OUR DEPARTMENT COULD HANDLE IT IF THE BOARD CHOSE TO DO THAT. A SEARCH FIRM IS GOING TO COST 120,000, THE TOTAL COST, ADVERTISING, THE FEES FOR THE SEARCH FIRM AND SO FORTH. WE DO IT FOR ABOUT HALF OF THAT. WE COULD DO IT IN-HOUSE IF YOUR BOARD CHOSE TO DO IT. 

SUP. BURKE, CHAIR: ALL RIGHT, WELL THEN SUPERVISOR YAROSLAVSKY WILL AMEND HIS MOTION TO PROVIDE THAT IT BE AN IN-HOUSE NATIONAL SEARCH AND I WILL SECOND THAT. CALL THE ROLL. 

CLERK VARONA-LUKENS: SUPERVISOR MOLINA. 

SUP. MOLINA: YEA. 

CLERK VARONA-LUKENS: SUPERVISOR YAROSLAVSKY. 

SUP. YAROSLAVSKY: YEA. 

CLERK VARONA-LUKENS: SUPERVISOR KNABE. 

SUP. KNABE: YEA. 

CLERK VARONA-LUKENS: SUPERVISOR ANTONOVICH. YEA. 

CLERK VARONA-LUKENS: AND SUPERVISOR BURKE. 

SUP. BURKE, CHAIR: YEA. SO ORDERED. 

SUP. KNABE: MADAM CHAIR THE OTHER ITEM THAT I HELD WAS 74-A. SUPERVISOR ANTONOVICH'S MOTION. I GUESS WHAT I'M TRYING TO GET IS, MIKE, ARE YOU TRYING JUST TO REPORT BACK REGARDING THE POLICY? I HAVE A HARD TIME WITH US CLOSING HOSPITALS AND CUTTING WAY BACK THAT WE WOULD BE SPENDING ADDITIONAL DOLLARS TO INSPECT. 

SUP. ANTONOVICH: RIGHT AND YOU RECEIVED YESTERDAY FROM THE LOS ANGELES COUNTY MEDICAL ASSOCIATION THE SHOCKING RESULTS THAT THEY HAD DISCOVERED IN THE SCHOOLS IN LONG BEACH SUPPORTING THIS, THIS ACTION. WHAT HAPPENED, YOU HAD A INVESTIGATION OF 70 PUBLIC SCHOOLS, TOILET FACILITIES, AND THEY FOUND THAT THEY WERE LOCKED DURING -- BEFORE LUNCH AND AFTER LUNCH. THEY FOUND THAT 68 DID NOT HAVE THE CLEAN TOILETS OR SINKS, EIGHT SCHOOLS TESTED POSITIVE FOR FECAL CONTAMINATION, AND ALL BATHROOMS, AS I SAID, WERE LOCKED BEFORE AND AFTER LUNCH. WE HAVE A SERIOUS PROBLEM AND I SPEAK AS A FORMER CLASSROOM INSTRUCTOR. YOU CANNOT TEACH CHILDREN AND CHILDREN CANNOT LEARN IF THEY'RE DENIED THE RIGHT TO GOING TO THE REST ROOM FOR THE ENTIRE DAY. THERE WERE KIDS WHO SAID THEY WOULDN'T GO UNTIL THEY GOT HOME, AND IT'S A VERY DISRUPTIVE PRACTICE. AND WE'RE ASKING THE DEPARTMENT OF HEALTH TO LOOK AT REVIEWING THE INSPECTION POLICIES. IT'S IMPORTANT THAT WE HAVE OUR SCHOOLS BEING ABLE TO MEET THE EDUCATIONAL AND HEALTH NEEDS OF OUR STUDENTS, AND I BELIEVE THE DEPARTMENT OF HEALTH HAS AN OPPORTUNITY OF COMING BACK WITH COUNTY COUNSEL, MAKING SOME RECOMMENDATIONS. 

SUP. KNABE: WELL I BELIEVE AND I AGREE THE SCHOOLS HAVE THAT RESPONSIBILITY, JUST THAT WE DON'T GET STUCK WITH THE COST. I MEAN YOU CAN ASK SOMEBODY FROM THE DEPARTMENT OF HEALTH SERVICES, BUT I'M BEING TOLD THAT SHOULD THEY BE ASKED TO DO INSPECTIONS LIKE THAT WOULD BE A VERY SIGNIFICANT COST TO US. THE SCHOOL DISTRICTS WANT TO REIMBURSE US, THAT'S ONE THING, BUT... 

SUP. ANTONOVICH: HAVING CHILDREN DENIED THE OPPORTUNITY OF USING REST ROOMS AND CLOSING OUR EYES TO AN OPPORTUNITY OF ADDRESSING THAT PROBLEM IS WRONG. 

SUP. BURKE, CHAIR: DON'T WE HAVE A RESPONSIBILITY, IF THERE'S A PUBLIC HEALTH HAZARD OR IF THERE'S A PUBLIC HEALTH SITUATION -- 

SUP. KNABE: OH WE HAVE 87 SCHOOL DISTRICTS. 

SUP. BURKE, CHAIR: DON'T WE HAVE THAT RESPONSIBILITY, NO MATTER WHERE IT IS? 

COUNSEL PELLMAN: MADAM CHAIR, WITH MANY ASPECTS OF THE OPERATION OF SCHOOLS, THE STATE PREEMPTS THE COUNTY AND THE CITY FROM DOING THINGS. FOR EXAMPLE, WE'RE PREEMPTED WITH RESPECT TO THEIR CAFETERIA SERVICES, BUT THERE MIGHT BE SOMETHING TO HAVE THE DEPARTMENT HELP WITH EDUCATING THE SCHOOL DISTRICTS REGARDING SOME MEASURES AND PUTTING THE SPOTLIGHT ON THE PROBLEMS THAT SUPERVISOR ANTONOVICH IS DISCUSSING. 

SUP. BURKE, CHAIR: DR. FIELDING. 

DR. JONATHAN FIELDING: WE DO, SUPERVISOR. WE WERE ALSO CONCERNED ABOUT WHAT WE SAW IN THAT INVESTIGATIVE REPORT, THOSE CONDITIONS WERE DEPLORABLE. IT'S HARD TO KNOW EXACTLY WHAT LEVEL OF PUBLIC HEALTH RISK THAT BRINGS WITH IT. WE HAVEN'T HAD REPORTS OF ILLNESS DIRECTLY LINKED TO THAT, BUT THAT DOESN'T MEAN IT DOESN'T EXIST, AND CERTAINLY THE FINDINGS THAT WERE THERE COULD CERTAINLY INCREASE THE RISK FOR SOME CHILDREN AND STAFF IN THOSE ENVIRONMENTS. WE DO NOT HAVE JURISDICTION CURRENTLY. WE DO INVESTIGATE ON A COMPLAINT BASIS. IN 2001, WE INVESTIGATED 54 COMPLAINTS AT THE SCHOOLS, AND LAST YEAR, 75. MOST OF THEM, THE HIGHEST NUMBER WERE FOR GENERAL SANITATION. AFTER THAT WERE FOR REST ROOMS AND THEN ALSO FOR CAFETERIA. IN THOSE SITUATIONS WE INVESTIGATED WE MAKE RECOMMENDATIONS TO THE SCHOOL SYSTEM AND THEN WE DO A REINSPECTION, BUT IT'S REALLY UP TO THE SCHOOL SYSTEM TO CARRY THROUGH, AND AS BEST I UNDERSTAND IT, THERE ARE NO EXPLICIT STANDARDS THAT THE SCHOOL HAS, ALTHOUGH THERE ARE -- THERE IS AN ENVIRONMENTAL HEALTH UNIT, FOR EXAMPLE, IN L.A.U.S.D. THAT HAS THE RESPONSIBILITY FOR THAT. WE ARE ALLOWED ON THE SCHOOL -- THEY MAKE A DECISION WHETHER TO ALLOW US TO COME ON THE PREMISES AND IN EVERY CASE EXCEPT ONE THAT I'M AWARE, WE'VE BEEN ALLOWED TO GO ON THE SCHOOL PROPERTY. 

SUP. ANTONOVICH: BUT TELLING A CHILD TO HOLD IT ALL DAY WILL NOT ALLOW THAT CHILD TO HAVE THE ABILITY TO CONCENTRATE AND DO THEIR WORK. THAT IS UNHEARD OF. I MEAN, THAT IS IRRESPONSIBLE AND YOU HAVE SCHOOLS WITH 4,000 STUDENTS WITH LOCKED REST ROOMS? TOTALLY IRRESPONSIBLE, BY EVERY PRINCIPAL AND SUPERINTENDENT AND EDUCATOR IN THAT SYSTEM, AND THIS IS AN ATTEMPT TO ADDRESS A WRONG. I MEAN WE'RE DENYING THIS TO OUR YOUNG PEOPLE. I KNOW IF THEY LOCK THE REST ROOMS FOR THE FACULTY AND TOLD THEM TO WAIT 'TIL THEY GO HOME, ALL HELL WOULD BREAK OUT, BUT SOMEHOW FOR THE KIDS, IT'S OKAY, AND THAT'S WHAT THIS IS AN ATTEMPT TO DO, TO ADDRESS THAT ISSUE. 

DR. JONATHAN FIELDING: I CERTAINLY CONCUR WITH THE CONCERN, SUPERVISOR, AND FOR SCHOOL HYGIENE THE BASIC STANDARDS OF CLEANLINESS AND HYGIENE FOR ITS STUDENTS REALLY HAVE TO BE A EXTREMELY HIGH PRIORITY, AND I'M NOT SURE THEY'VE ALWAYS BEEN A PRIORITY AT THAT LEVEL. 

SUP. ANTONOVICH: IN OUR JAILS, IT'S WHAT 16-TO-1 TO HAVE A TOILET FACILITY AVAILABLE. SO THAT'S WHAT THE ATTEMPT -- THE MOTION IS TO HAVE THE DEPARTMENT OF HEALTH AND THE COUNTY COUNSEL TO REVIEW WHAT OPTIONS WE HAVE AND I KNOW THAT IF STATE LEGISLATION'S REQUIRED, THERE ARE STATE LEGISLATORS WHO HAVE OFFERED TO INTRODUCE ADDITIONAL LEGISLATION TO CORRECT THIS PROBLEM. 

DR. JONATHAN FIELDING: I THINK THE OTHER ISSUE, AS YOU'VE INDICATED, SUPERVISOR, FUNDING. CURRENTLY WE KIND OF DO THIS, BUT WE REALLY HAVE VERY LIMITED CAPACITY TO DO THIS. WE DO IT ON A COMPLAINT BASIS, ON A LIMITED BASIS, IF WE ARE GOING TO HAVE AN OVERALL PROGRAM CERTAINLY WE'D HAVE TO GET THE RESOURCES ASSOCIATED WITH THAT. 

SUP. ANTONOVICH: WELL WE KNOW THROUGH YOUR EFFORTS WE MADE A DRAMATIC IMPROVEMENT IN THE RESTAURANTS IN THIS COUNTY WITH THE LETTER GRADE PROGRAM, AS A RESULT OF THAT, PEOPLE ARE EATING IN CLEANER RESTAURANTS TODAY AND HAVE GREATER CONFIDENCE AND IT SEEMS TO ME THAT SAME LEVEL OF COOPERATION CAN RESULT IN IMPROVING OUR EDUCATION FACILITIES. 

SUP. YAROSLAVSKY: WELL MIKE, ON THAT POINT, IT'S A GOOD POINT, BUT WE'RE CHARGING THE RESTAURANTS A FEE FOR THE COST OF DOING THAT, AND I THINK WHAT DR. FIELDING IS SAYING, AND I THINK WE ALL AGREE ON THIS IS SCHOOLS SHOULD BE POLICING THIS THEMSELVES. IF THEY CAN'T POLICE IT THEMSELVES AND WE HAVE TO COME IN THERE AND DO IT FOR THEM, WE SHOULDN'T BE ASKED TO PICK UP THE TAB FOR IT. THAT WAS AND DON'S POINT. AND IT'S AN EMBARRASSMENT, FRANKLY. 

SUP. KNABE: OH I AGREE WITH MIKE AND YOU, I MEAN IT'S AN EMBARRASSMENT, BUT, I MEAN, TO ASK US PICK UP THAT COST. 

SUP. ANTONOVICH: I DO NOT WANT TO SEE CHILDREN DENIED THE RIGHT OF HAVING THE OPPORTUNITY OF LEARNING, AND IF THIS IS A WAY OF GETTING THE ATTENTIONS OF THE SCHOOL DISTRICTS AND ADDRESSING A VERY SERIOUS PROBLEM, IT'S A STEP IN THE RIGHT DIRECTION. WE'LL GET THAT INFORMATION BACK FROM THE DEPARTMENT OF HEALTH AND COUNTY COUNSEL AND WE CAN WORK COOPERATIVELY WITH THE STATE IF ADDITIONAL STATE LAWS ARE REQUIRED, BUT IN THE MEANTIME, WE OUGHT NOT TO LET THE SCHOOL DISTRICTS OFF THE HOOK, AND I BELIEVE THIS IS A VERY POSITIVE AND CONSTRUCTIVE MOTION. 

SUP. YAROSLAVSKY: I AGREE, YOU KNOW, I JUST IT OCCURS TO ME THAT YOU WOULD BE WITHIN YOUR RIGHTS AND THE DEPARTMENT'S RIGHTS TO SHUT DOWN A SCHOOL, WOULDN'T YOU? 

DR. JONATHAN FIELDING: USING THE POLICE POWERS AS OPPOSED TO OUR CURRENT REGULATORY -- NORMAL REGULATORY POWERS, WE WOULD. 

SUP. YAROSLAVSKY: AND IF YOU -- ALL YOU HAD TO DO IS SHUT DOWN ONE SCHOOL AND COST THE SCHOOL DISTRICT THAT AVERAGE DAILY FUNDING THAT THEY GET FROM SACRAMENTO FOR THAT SCHOOL, AND I THINK IT WOULD GET THEIR ATTENTION IF YOU HAD TO, AND I HOPE IT DOESN'T COME TO THAT, BUT THIS IS -- THAT IT HAS TO COME TO OUR LEVEL IS RIDICULOUS, BUT I THINK WE HAVE SOME TOOLS AND I WOULDN'T HESITATE TO USE THEM IN THE INTEREST OF THE KIDS. 

SUP. BURKE, CHAIR: ALL RIGHT. 

SUP. ANTONOVICH: MOVE THE MOTION. 

SUP. BURKE, CHAIR: IS THERE A SECOND TO THE MOTION? 

SUP. KNABE: I'LL SECOND. 

SUP. BURKE, CHAIR: ALL RIGHT. IT'S MOVED AND SECONDED. WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: THANK YOU. 

SUP. BURKE, CHAIR: ARE THERE OTHER ITEMS THAT WE HAVE NOT COVERED? 

SUP. KNABE: THAT'S ALL MY HOLDS. 

SUP. BURKE, CHAIR: THAT'S ALL OF YOUR HOLDS. ALL RIGHT. SUPERVISOR ANTONOVICH? OKAY. 

SUP. ANTONOVICH: ALSO, RELATIVE TO THE ASTRONAUTS, I WOULD JOIN WITH THAT EFFORT TO JOIN IN THE MEMORY. I HAD THE OPPORTUNITY OF TOURING THE SPACE SHUTTLE WHEN IT WAS BEING REFURBISHED AT THE PALMDALE FACILITY A FEW YEARS AGO, AND IT WAS VERY TRAGIC TO SEE IT DESTROYED, TAKING THE LIVES OF SEVEN ROLE MODELS FOR THIS COUNTRY, SEVEN GREAT INDIVIDUALS WHO HAD SO MUCH TO CONTRIBUTE, BUT I HAVE A MOTION MOTION, THE TRAGIC CRASH OF THE SPACE SHUTTLE THIS PAST SATURDAY TOUCHED EVERY CITIZEN IN THE UNITED STATES AND THROUGHOUT THE WORLD. THE SENSE OF LOSS IS BEING FELT IN LOS ANGELES COUNTY, ESPECIALLY IN THE ANTELOPE VALLEY WHERE COLUMBIA WAS BUILT AND MODIFIED OVER THE PAST 20 YEARS, TO RECOGNIZE THE CONTRIBUTION OF THE ENTIRE N.A.S.A. TEAM, THE ASTRONAUTS ABOARD COLUMBIA, AND THE MEN AND WOMEN WHO MADE COLUMBIA POSSIBLE, I WOULD LIKE TO MOVE THAT THE BOARD DIRECT THE DEPARTMENT OF PUBLIC WORKS TO BEGIN COORDINATING WITH THE CITIES OF PALMDALE AND LANCASTER TO STUDY THE FEASIBILITY OF CREATING AND IMPLEMENTING A PLAN TO RENAME AVENUE "M," WHICH IS THE MAIN STREET LEADING TO THE SPACE SHUTTLE MANUFACTURING SITE WHERE THE COLUMBIA WAS BUILT, AND IS IN THE CENTER OF THE ANTELOPE VALLEY, AS "COLUMBIA WAY" WITH A REPORT BACK TO THE BOARD IN 30 DAYS. I UNDERSTAND THAT THERE'S SIMILAR ACTIONS BEING DONE BY THE CITIES IN THE ANTELOPE VALLEY AS WELL. SO IF WE COULD MOVE THAT 'CAUSE WE'RE ASKING FOR A REPORT BACK. 

SUP. BURKE, CHAIR: MOVED AND SECONDED, REPORT BACK. WITHOUT OBJECTION, SO ORDERED. 

SUP. ANTONOVICH: THEN I WOULD LIKE TO MOVE THAT WE ADJOURN IN MEMORY OF CORNELIA GRISWALD WHO WAS AN EDUCATOR FOR OVER 25 YEARS WITH THE WALNUT VALLEY UNIFIED SCHOOL DISTRICT. AND SHE HAD RECEIVED NUMEROUS AWARDS FOR OUTSTANDING SERVICE INCLUDING TEACHER OF THE YEAR FOR THE DISTRICT AND FOR THE COUNTY OF LOS ANGELES. DR. BERKELEY BAILEY, PROFESSOR OF ANTHROPOLOGY AND ARCHAEOLOGY AT THE UNIVERSITY OF NEBRASKA. HE WAS BORN AND RAISED IN THE ANTELOPE VALLEY WHO PASSED AWAY UNEXPECTEDLY AT THE AGE OF 45. ART IS, BIG OCK A LONG-TIME ANTELOPE VALLEY RESIDENT AND MEMBER OF THE ANTELOPE VALLEY CLUB OF PRINTING HOUSE CRAFTSMAN. GLADYS CUNNINGHAM, WHO HELPED ORGANIZE THE P.T.A.s AND THE NEW SCHOOLS BEING ESTABLISHED IN LANCASTER AND ALSO ESTABLISHED THE ANTELOPE VALLEY CALIFORNIA POPPY RESERVE. IN MARCH SHE WAS HONORED BY THE LOS ANGELES COUNTY BOARD OF SUPERVISORS AND THE COMMITTEE ON AGING. JAMES ROLAND GARVIN OF THE ANTELOPE VALLEY. ARNETTE GERALD BRODIE OF THE SAN GABRIEL VALLEY WHO WAS NAMED THE REALTOR BROKER OF THE YEAR BACK IN 1987 AND HE WAS QUITE INVOLVED IN COMMUNITY PROGRAMS. SHIRLEY DOLORES HUSBANDS OF GLENDORA WHO WAS A MEMBER OF THE CHARTER OAK WOMEN'S CLUB, THE GLENDORA LIBRARY BOARD OF DIRECTORS AND THE COORDINATING COUNCIL AND THE RED CROSS. GARY LYNHART, WHO WAS FROM THE ANTELOPE VALLEY PRESS, LEDGER GAZAETTE, HE WAS THE PASTE-UP ARTIST AND HAD WORKED THERE FOR A NUMBER OF YEARS. ROBERT ROTAZI, OF SANTA CLARITA VALLEY, WHO WAS A RETIRED MECHANICAL ENGINEER FOR GRUMMAN AEROSPACE AND LOCKHEED AEROSPACE. AND RALPH RIDGEWAY OF THE ANTELOPE VALLEY. WE ADJOURN IN THEIR MEMORY. 

SUP. BURKE, CHAIR: SO ORDERED. 

SUP. ANTONOVICH: AND ON ITEM NUMBER 63, CONNIE McCORMICK. 

SUP. BURKE, CHAIR: DO YOU WANT THE DEPARTMENT TO COME UP? 

SUP. ANTONOVICH: SHE'S COMING. ON THE ISSUE, CAN YOU TELL US WHERE THE AGREEMENT PUTS US IN A TIME LINE TO PHASE IN THE NEW VOTING SYSTEM AS ORDERED BY THE COURT? 

CONNIE McCORMICK: THANK YOU, SUPERVISOR. YES, I'LL BE GLAD TO ANSWER ANY QUESTIONS ABOUT THIS AGREEMENT AND THE WHOLE PROCESS OF PHASING IN THE NEW VOTING TECHNOLOGY WHICH, AS YOU KNOW YOUR BOARD LAST AUGUST MADE A VERY WISE DECISION TO PHASE IN THE NEW SYSTEM OVER SEVERAL YEARS. AND ONE OF THE REASONS FOR THAT IS BECAUSE WE HAVE 88 CITIES IN THE COUNTY, AND UNLIKE ALL THE OTHER COUNTIES IN CALIFORNIA, THOSE 88 CITIES, WITH THE EXCEPTION OF 16 OF THEM, RUN THEIR OWN ELECTIONS. AND THE ISSUE HAS -- ONE OF THE MAIN ISSUES IS WHAT ARE WE GOING TO DO IN TERMS OF HAVING A COORDINATED COLLABORATIVE EFFORT. THE MOST IMPORTANT IN TERMS OF SIZE IS THE CITY OF LOS ANGELES, AND THEY ALSO DON'T HAVE A VOTING SYSTEM BECAUSE OF THE DECERTIFICATION PROCESS. AND WE FEEL VERY PLEASED TO BRING YOU THIS AGREEMENT THAT IS A COLLABORATION BETWEEN THE CITY OF LOS ANGELES AND THE COUNTY TO PARTNER IN THE ACQUISITION OF THE NEW SYSTEM. THIS IS THE FIRST STEP OF THE PARTNERSHIP, AND ONE OF THE BEST PIECES OF IT IS THAT, FOR THE FIRST TIME, WE'LL ACTUALLY HAVE RECIPROCITY ON HOW WE COULD COUNT EACH OTHER'S BALLOTS. CURRENTLY, IF SOMETHING WERE TO HAPPEN AT OUR COUNTING LOCATION OR THE CITIES, WE USE DIFFERENT SOFTWARE, WE WOULDN'T HAVE ANY ABILITY TO BACK EACH OTHER UP IN THE CASE OF A DISASTER, AND THIS IS ONE OF THE BIG BENEFITS OF THIS AGREEMENT, IS THAT WE WILL ALL BE ON THE SAME SOFTWARE PLATFORM ONCE THIS SOFTWARE IS LAUNCHED AT THE END OF 2003. 

SUP. ANTONOVICH: HOW IS THE FUNDING FOR THIS GOING TO BE DONE? 

CONNIE McCORMICK: THE AGREEMENT THAT WE SIGNED WITH THE COMPANY -- YOU SIGNED WITH THE COMPANY LAST APRIL WAS A 3-1/2-MILLION-DOLLAR AGREEMENT FOR AN INITIAL PURCHASE OF SOME TOUCH SCREEN VOTING EQUIPMENT, AS YOU KNOW WE'VE USED IN EARLY VOTING SO FAR FOR THE NOVEMBER 2002 ELECTION. A GOOD PIECE OF IT, THOUGH, IS FOR SOFTWARE FOR NEW BALLOT TALLY, AND THE AGREEMENT IS THE CITY OF LOS ANGELES IS ABOUT ONE-THIRD OF THE REGISTERED VOTERS IN THE COUNTY, AND SO THEY WOULD BE PICKING UP A THIRD OF THE COST, AND EVEN MORE SIGNIFICANTLY ALSO, THEY HAVE BETTER WAREHOUSING CAPABILITY THAN WE DO AND THEY WILL BE BUILDING OUT AND SPENDING MONEY TO HOUSE THIS EQUIPMENT, AND I THINK THAT'S A REAL BIG HELP BECAUSE WE DON'T HAVE THE CAPACITY IN OUR WAREHOUSE TO DO THAT. 

SUP. ANTONOVICH: HOW IS THIS GOING TO BE PHASED IN WITH THE INTERIM THE SCAN PAPER BALLOTS? 

CONNIE McCORMICK: THE PROCESS, AS WE'VE DONE IT SO FAR IS THAT EARLY VOTING WAS IN NOVEMBER OF '02. NOW THE CITY OF LOS ANGELES WILL FOR THE FIRST TIME DO EARLY VOTING IN CONJUNCTION WITH THEIR MARCH 4th UPCOMING ELECTION, BETWEEN FEBRUARY 18th AND 28th. AND THEN ON MARCH 4th, THERE ARE 55 OTHER CITIES HOLDING ELECTIONS, AND 6 OF THEM WE WILL BE ASSISTING THEM IN CONDUCTING WITH TOUCH SCREEN VOTING EQUIPMENT. THE INTERIM PAPER-BASED VOTING SYSTEM THAT WILL BE COMING IN THIS NOVEMBER IN THE COUNTY'S OFF-YEAR CONSOLIDATED SCHOOLS AND CITIES ELECTIONS, SCHOOLS AND WATER SCHOOL DISTRICT ELECTIONS WILL BE THE FIRST INTRODUCTION OF THE NEW PAPER-BASED SYSTEM, AND THE EARLY VOTING TOUCH SCREEN WILL CONTINUE THROUGH THE PRESIDENTIAL ELECTION AS WE TRANSITION, WE HOPE, BY 2005 INTO ALL TOUCH SCREEN DEPENDING ON FUNDING, OF COURSE. 

SUP. ANTONOVICH: AND ON THE SENATE BILL 90 REIMBURSEMENTS? 

CONNIE McCORMICK: WHAT WE'RE HOPING FOR IN TERMS OF THE FUNDING OF THE EVENTUAL COUNTY-WIDE TOUCH SCREEN HUNDRED-MILLION-DOLLAR ESTIMATE TO DO THAT IS THE PROP 41 FUNDING IN SACRAMENTO, WOULD GIVE THE COUNTY 49 MILLION OF THAT. THAT AMOUNT IS RESERVED FOR COUNTY OF LOS ANGELES. IT'S NOT IMPACTED BY S.B.90. HOWEVER, THE FEDERAL FUNDING IS STILL IN FLUX, AS ALL OF YOU KNOW. THERE'S NO BUDGET YET IN THE 2003 YEAR OR NEXT YEAR. HOWEVER, WE'RE HOPEFUL THAT SOME FEDERAL FUNDING WILL BE COMING TO -- OUR WAY BY THIS SUMMER AND AFTER WE FIND OUT HOW MUCH THAT'LL BE, WE'LL BE IN A BETTER POSITION TO JUDGE WHAT THE SHORTAGE WILL BE AT THAT POINT. 

SUP. ANTONOVICH: THANK YOU. I'LL MOVE IT. 

SUP. BURKE, CHAIR: MOVED BY SUPERVISOR ANTONOVICH SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. THANK YOU. I'M GOING TO MOVE THAT WE RECONSIDER THE ADJOURNMENT OF THE FEBRUARY -- LAST WEEK'S MEETING. MOVED BY BURKE, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, THAT'S RECONSIDERED. THE MEETING IS NOW RE-- WE WILL RECONVENE AND CALL TO ORDER THAT MEETING. AND ON AGENDA ITEM NUMBER 2, AFTER TABULATING THE BALLOTS, A DETERMINATION HAS BEEN MADE THAT NO MAJORITY PROTEST EXISTS AGAINST THE PROPOSED ASSESSMENT. AS A RESULT, I MOVE THAT THE BOARD ADOPT THE RESOLUTION TO ANNEX AND LEVY ASSESSMENTS FOR EACH PETITION AREA. AS TO AGENDA ITEM 3, AFTER TABULATING THE BALLOTS, A DETERMINATION HAS BEEN MADE THAT NO MAJORITY PROTEST EXISTS AGAINST THE PROPOSED ASSESSMENTS. AS A RESULT, I MOVE THAT THE BOARD ADOPT THE RESOLUTION TO ANNEX AND LEVY ASSESSMENTS FOR EACH SUBDIVISION AREA. AND ITEM 2 IS SECONDED BY SUPERVISOR ANTONOVICH, AND ITEM 3 IS SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, ITEM 2 IS SO ORDERED AND ITEM 3 IS SO ORDERED. SUPERVISOR YAROSLAVSKY MOVES THAT WE ADJOURN THE MEETING OF JANUARY 28th. WITHOUT OBJECTION, THAT MEETING IS ADJOURNED. WE NOW HAVE -- IS PUBLIC COMMENT NEXT IN ORDER? DO WE HAVE ANYTHING ELSE BEFORE US? WE HAVE PUBLIC COMMENT. LEONARD WAYNE ROSE, JR., MARVIN DARDEN, AND EDWARD SALDANA. PLEASE COME FORWARD. 

LEONARD WAYNE ROSE, JR.: I BEGIN TO SPEAK NOW? YEAH LEONARD WAYNE ROSE, JR. I GOT A FEW SCRIPTURES SUBMITTED TO THE AUTHORITY, PUT GOD FIRST IN PRAYER. ROMANS 13, VERSE 1 TO 7. EVERYONE MUST SUBMIT HIMSELF TO AUTHORITY, GOVERNOR AUTHORITY FOR THERE IS NO AUTHORITY EXCEPT THAT WHICH GOD HAS ESTABLISHED AUTHORITY, THAT THIS HAS BEEN ESTABLISHED BY GOD. CONTINUE WHO REBEL AGAINST AUTHORITY AS WE REBEL AGAINST WHAT GOD HAS INSTITUTED THOSE WHO DO SO WILL BRING JUDGMENT TO THEM SELF, FOR HOLD NO TERROR FOR THOSE WHO DO RIGHT, BUT THOSE WHO DO WRONG DO NOT WANT TO BE FREE FROM FEAR OF THE ONE IN AUTHORITY, THEN DO WHAT IS RIGHT AND WILL COMMEND YOU FOR HE IS GOD'S SERVANT TO DO YOU GOOD, BUT IF HE DID WRONG, BE AFRAID, FOR HE DO NOT BEAR THE SWORD FOR NOTHING. HE IS GOD'S SERVANT. THEY BRING UPON ON THE WRONG- DOER. THEREFORE IT IS NECESSARY TO SUBMIT TO AUTHORITY, NOT ONLY BECAUSE POSSIBLE PUNISHMENT BUT ALSO OF THE SIN. THIS IS ALSO WHY WE PAY TAXES FOR THE AUTHORITY OF GOD'S SERVANTS WHO GIVE THEIR FULL TIME TO GOVERNOR. GIVE EVERYONE WHO OWE HIM, IF OWE TAXES, PAY TAX THEN REVENUE. IF HONORED, THEN HONOR. HEBREWS 13, VERSE 17, OBEY OUR LEADERS AND SUBMIT TO AUTHORITY WHO KEEP OVER AS A MAN WHO MUST GIVE ACCOUNT, OBEY THEM SO THAT WORK WILL BE JOY AND NOT BURDEN WOULD BE OF ADVANTAGE TO YOU. THIS IS FROM GOD'S WORD N.I.V. I'M WRITING LETTER TO YOU GUYS THIS YEAR AND GEORGE BUSH AND ALL AUTHORITY AND PUT GOD FIRST, AND IF YOU NEED HELP, GOD WILL HELP YOU AND GUIDE YOU WITH ALL YOUR THINGS IN WHAT YOU DO IN OFFICE AND THE WORK TOGETHER WITH THE POLICE DEPARTMENT AND CITY OFFICE AND GOVERNOR AND PRESIDENT AND THANK YOU GUYS TO PASS THE HELMET LAW. THIS YEAR THE UNDER 18-YEAR-OLD AND HAVE SAFE MOVE PROGRAM FOR CHILDREN AND THANK YOU FOR YOU GUYS HELPING ME OUT. THANK YOU VERY MUCH. THANK YOU. 

MARVIN DARDEN: FIRST GIVING HONOR TO God WHICH IS JESUS CHRIST, TO OUR DISTINGUISHED CHAIR AND COUNCIL MEMBERS. MY NAME IS MARVIN DARDEN. I LIVE IN THE CITY OF PALMDALE. ON AUGUST 9th OF LAST YEAR AFTER BEING STOPPED FOR TWO MONTHS MY CAR WAS VANDALIZED AND I WAS SEVERELY BEATEN IN FRONT OF MY PALMDALE RESIDENCE BECAUSE I WAS PERCEIVED TO BE GAY. THIS IS A CASE IN WHICH BOTH SUSPECTS, CAMERON HUNT AND HIS GIRLFRIEND, SHIRLINE BAEZ ARE GUILTY FOR VIOLATING MY CIVIL RIGHTS. CAMERON HUNT WAS CHARGED WITH A HATE CRIME VIOLATING CALIFORNIA CIVIL CODE SECTION 51.7 THE RALPH CIVIL RIGHTS ACT, BATTERY AND SERIOUS BODILY INJURY VIOLATING PENAL CODE 422.75-A AND VANDALISM PENAL CODE 422.6-B. I'M ALSO A DISABLED PERSON, ON APRIL THE 4th OF 2000 I SUFFERED A BRAIN ANEURYSM, SO I WAS UNABLE TO DEFEND MYSELF. AFTER POLICE MISCONDUCT AND A FLAWED AND BOTCHED INVESTIGATION, DISTRICT ATTORNEY PATILLO AND DENTON DROPPED ALL CHARGES IN THE CASE. PLEASE FIND ATTACHED IN EVIDENCE TO SUBSTANTIATE THESE COMMENTS, COMPLAINTS, I BIG YOUR PARDON. HOW LONG BEFORE AS AMERICANS MUST WE TOLERATE BEATINGS AND SOMETIMES EVEN DEATH BEFORE OUR ELECTED LEADERS WILL PROSECUTE THESE CRIMES. I HAVE ASKED SHERIFF BACA FOR HIS HELP, TO NO AVAIL. MR. BACA SPOKE ON NATIONAL AND LOCAL TELEVISION HOW WE, THE PEOPLE OF LOS ANGELES COUNTY, HAD HIS SUPPORT. UNTRUE. I HAVE ALSO ASKED THE L.A. COUNTY HUMAN RELATIONS COMMISSION FOR ITS HELP REGARDING THE HATE CRIME, TO NO AVAIL. I HAVE ASKED THE CITY COUNCIL OF PALMDALE, CALIFORNIA FOR ITS HELP, TO NO AVAIL. I HAVE EVEN ASKED THE PALMDALE HATE CRIME TASK FORCE, BUT ITS HELP, TO HAVE THE COMMITTEE AND DARREN PARKER TURN ITS BACK ON ME. I HAVE EXHAUSTED THE RANKS OF LOCAL AUTHORITY AND AM I NOT ENTITLED TO JUSTICE? OR EVEN HELP? NOW I TURN TO YOU AND THIS COUNCIL, FOR ITS HELP. IN THESE TIMES WHERE THE CALIFORNIA BUDGET IS A SERIOUS PROBLEM, I ASK THIS BODY AND COUNCIL TO SERIOUSLY CONSIDER THE CONTINUED FUNDING OF SOME OF THESE ORGANIZATIONS. 

SUP. BURKE, CHAIR: SIR, I THINK THAT YOUR TIME HAS ELAPSED, BUT WE WILL HAVE SOMEONE TO TALK TO YOU. 

MARVIN DARDEN: OKAY. THANK YOU VERY MUCH. 

SUP. ANTONOVICH: WE HAVE -- IS ROBIN TULMA HERE FROM THE HUMAN RELATIONS COMMISSION? 

MARVIN DARDEN: I JUST HAVE ONE MORE THING TO SAY. 

SUP. BURKE, CHAIR: OKAY SURELY. 

MARVIN DARDEN: I WILL CONTINUE TO WORK WITH THE N.A.A.C.P., THE SENATE, AND THE UNITED STATES CONGRESS TO SUPPORT THE HATE CRIMES BILL THAT WOULD ALLOW THE FEDERAL GOVERNMENT TO WORK WITH THE STATE AND LOCAL AUTHORITIES TO PUNISH MORE HATE CRIMES TO THE FULLEST EXTENT POSSIBLE. I THANK YOU FOR YOUR TIME. 

SUP. ANTONOVICH: FROM THE HATE CRIMES -- THE HUMAN RELATIONS COMMISSION? 

SUP. BURKE, CHAIR: WE'LL HAVE SOMEONE COME OUT FROM HUMAN RELATIONS COMMISSION. JUST HAVE A SEAT OVER THERE AND THEY'LL BE. DID I CALL EDWARD SALDANA? WE'VE HEARD FROM MARVIN DARDEN AND LEONARD WAYNE ROSE. EDWARD SALDANA, DAVID ALTENBERG AND CONNIE S.LARGE, CONNIE J. LARGE. PLEASE COME FORWARD. 

SPEAKER: SIX COPIES OF MATERIALS. 

SUP. BURKE, CHAIR: ALL RIGHT, IS JOHN GILL HERE, MAYBE HE CAN -- HE DIDN'T HAVE ANYTHING TO DO WITH THAT. WE'LL SEE IF WE CAN REACH SOMEONE FROM HUMAN RELATIONS COMMISSION. ALL RIGHT. IF YOU'LL GIVE HIM YOUR -- HOW THEY CAN REACH YOU, WE WILL GET A HUMAN RELATIONS COMMISSIONER WHO'S NOT HERE AT THIS TIME, BUT TO GET BACK IN TOUCH WITH YOU. ALL RIGHT. IF YOU'LL LEAVE, WE HAVE YOUR ADDRESS, BUT IF YOU'LL JUST LEAVE IT AGAIN. WE'RE GOING TO CONTINUE TO SEE IF THERE'S SOMEONE HERE. YES, PLEASE, STATE YOUR NAME, PLEASE. 

DAVID ALTENBERG: GOOD MORNING. I'M DAVID ALTENBERG. I'D LIKE TO SPEAK TO THE TOPIC WHICH HAS BEEN DISCUSSED BEFORE REGARDING THE RELOCATION OF OLD GLORY OAK TREE IN AN AREA ADJACENT TO SANTA CLARITA. MY REQUEST SPECIFICALLY IS THAT THIS ISSUING BE DESIGNATED AS AN AGENDA ITEM FOR AN UPCOMING BOARD OF SUPERVISORS HEARING. I'M SURE YOU'RE AWARE THERE'S BEEN A GREAT DEAL OF COMMUNITY AND MEDIA INTEREST IN THIS TOPIC OVER THE PAST SEVERAL MONTHS. MANY OFFICES OF THE SUPERVISORS ARE RECEIVING PHONE CALLS AND LETTERS ON THIS ISSUE. MY CONTENTIONS AND THE BASIS FOR THE REQUEST FOR A HEARING ARE AS FOLLOWS. FIRST OFF, I BELIEVE THAT THE REASONS PROVIDED FOR MOVING THE TREE AT THIS TIME ARE NOT VALID. IT HAS BEEN STATED BY THE ARBORISTS THAT THEY WANTED TO USE THE QUOTE, UNQUOTE, DORMANT PERIOD OF WINTERTIME TO SEVER THE ROOTS TO PREPARE FOR THE MOVE. HOWEVER, IT IS VISUALLY OBVIOUS TO ANYONE WHO SEES THE TREE IN ITS CURRENT STATE, IT IS IN A SPRING MODE. IT IS BRIGHT GREEN AND LEAFY, QUITE POSSIBLY IN A REACTION TO THE VERY WARM JANUARY WE'VE HAD. ADDITIONALLY IN A LONGER RANGE, I FEEL THERE'S NO NEED AT THIS TIME OR AT ANY TIME IN THE NEAR FUTURE FOR THIS MOVE. THE BORDERING NEWHALL RANCH DEVELOPMENT HAS NOT YET COMPLETED ITS APPLICATIONS FOR A SUBDIVISION, SO THE NEED FOR THE ROAD IS NOT CLEARLY ESTABLISHED. AS IT IS NOW, THE ROAD ONLY LEADS TO A SMALL PARK AND A BORDERING PROPERTY. IT DOES NOT HAVE ANY TRAFFIC -- SIGNIFICANT TRAFFIC THAT WOULD REQUIRE FOUR LANES. ADDITIONALLY, I FEEL THAT IN REFLECTION WITH THE RECENT TRAFFIC STUDY LETTER DELIVERED BY JAMES NOYES LATE LAST NIGHT TO BOARD MEMBERS THAT THE BOARD WILL HAVE TIME TO LOOK AT THIS LETTER AND EVALUATE IT IN TERMS OF PERHAPS SOME EVIDENT BIAS TOWARDS THE STATUS QUO. THE APPARENT CONTRADICTION OF MR. NOYES WITH ITS EARLY FINDING THAT THE ROAD COULD BE DOWNGRADED TO A SECONDARY ROAD FROM A MASTER HIGHWAY, AND THE FACT THAT MR. NOYES DIDN'T CONSIDER PRESENTED ALTERNATIVE AND AVAILABLE FEASIBLE ALTERNATIVES, THAT IS, TO WHAT HE DECLARES AS A NEED FOR DESIGN FOR A 65-MILE-AN-HOUR HIGHWAY FOR RESIDENTIAL NEIGHBORHOODS AND A SCHOOL ZONE. AS YOU KNOW, THERE HAVE BEEN ALTERNATE PLANS SUBMITTED ON THIS. I THINK THE RELIANCE ON THE ORIGINAL 1940 MASTER PLAN WHICH HAS BEEN CITED IN NEWS REPORTS IS QUESTIONABLE AND QUITE POSSIBLY INVALID BECAUSE THAT ORIGINAL PLAN DID NOT CONSIDER THE IMPACT OF FREEWAYS IN THE SANTA CLARITA VALLEY, WOULD SIGNIFICANTLY CHANGE YOUR TRAFFIC MODELS. THERE HAS BEEN PRESENTED A DETAILED SOLUTION OPTION INCLUDING DECOUPLING OF THE REST OF THIS ROAD FROM THE COMPLETION BOND WITH THE DEVELOPER, LIABILITY ISSUES HAVE BEEN ANSWERED WITH THE CONCEPT OF A BOND ISSUE FROM THE MOUNTAINS CONSERVANCY, AND I BELIEVE THAT THIS MATTER IS WITHIN THE BOARD'S JURISDICTION, PERHAPS MORE READILY THAN WITHIN THE COURTS, WHICH HAS BEEN SUGGESTED AS AN ALTERNATIVE. FINALLY, THE RELOCATION PROCEDURES NOW UNDERWAY VIOLATE YOUR OWN FORESTRY DIVISION'S OAK TREE PROTECTED ZONE STANDARDS. THERE IS QUESTIONS WHETHER THE OAK TREE PERMIT IS VALID AND THERE ARE OTHER LIABILITY AND LEGAL EXPOSURES THAT COULD BE ADDRESSED BY COUNTY COUNSEL. THANK YOU FOR LISTENING. I WOULD APPRECIATE AGENDA DESIGNATION. 

SUP. BURKE, CHAIR: THANK YOU. CONNIE S. LARGE AND EDWARD SALDANA. I DO NOT HEAR THEM RESPONDING. THAT CONCLUDES PUBLIC COMMENT. ARE THERE ANY OTHER PEOPLE WHO HAVE INDICATED THEY WANT TO BE HEARD? OKAY. 

CLERK VARONA-LUKENS: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING THE SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE; ITEM CS-2, CONFERENCE WITH LABOR NEGOTIATORS, CHIEF ADMINISTRATIVE OFFICER DAVID E. JANSSEN AND DESIGNATED STAFF, ITEMS CS-3 AND CS-4, CONFERENCES WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION. ITEM CS-5, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE, AS INDICATED ON THE POSTED AGENDA AND THE SUPPLEMENTAL AGENDA. ALSO, ITEM CS-1 FROM THE ADJOURNED REGULAR MEETING OF JANUARY 28th, 2003, HELD ON FEBRUARY 3rd, 2003, AND CONTINUED TO FEBRUARY 4, 2003, TO CONSIDER CANDIDATES TO THE POSITION OF DIRECTOR CHILDREN AND FAMILY SERVICES PURSUANT TO GOVERNMENT CODE SECTION 54957. THANK YOU. 

SUP. BURKE, CHAIR: RIGHT, WE'LL NOW ADJOURN TO CLOSED SESSION. 

REPORT OF ACTION TAKEN IN

CLOSED SESSION ON FEBRUARY 4, 2003

The Board of Supervisors met yesterday in Closed Session regarding the following:

PUBLIC EMPLOYMENT

Consider candidates to the position of Director of Children and Family Services, pursuant to Government Code Section 54957.

TODAY'S ANNOUNCEMENT:

On February 4, 2003, the Board of Supervisors met in Closed Session to consider candidates for appointment to the position of Director of Children and Family Services, pursuant to Government Code Section 54957.

Pursuant to County Code Section 2.06.010, the Board appointed David Sanders to the position of Director of Children and Family Services, effective March 24, 2003, and instructed the Director of Personnel to negotiate an annual salary.  The Board also instructed the Director of Personnel to execute an at-will employment contract which is approved as to form by the County Counsel subsequent to approval of an annual salary for David Sanders by the Board of Supervisors.

The vote of the Board of Supervisors was unanimous.
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